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1Getting Started

What to Expect
Follow corporate guidelines for all artwork. No substitions of software, fonts, and procedures are
accepatable. 

Required information for all jobs:
• PDP form
• Bill of material print outs
• Job folder
• Marketing direction when applicable
• Reference files when applicable
• Material type & Gauge
• Dimensions if not standard size or PK available.

Computer set-up:
All computers have been set up per corporate standards. Your desktop should be as per page 7 of this
manual.

Reference files/materials:
ISO Procedures - Details all procedures for the department.
Design manual - Details all processes, design specs, production specs, warning statements etc.
Server - Repository of all digital art.

Workflow process:
� Create art - Reference ISO Procedure LNPDA-P205 - Creating Packaging Art.

� Peer Approval - Reference ISO Procedure LNPDA-P240 - Internal apporval process.

� External Aproval - Reference ISO Procedure LNPDA-P245 - External apporval process. Email templates
can be found in the Design Resource Library on the server.

� Prepare files for production - Reference ISO Procedure LNPDA-P255 - Preparing Packaging Art for
Production. See Chapter 5 in Design manual.

� File art on server - Reference ISO Procedure LNPDA-P270 - Filing Approved Packaging Art to PDP
Server. See page 105 in design manual.

� Preparing Project folder - Reference ISO Procedure LNPDA-P260 - Preparing Completed Art Project folders.

� Releasing/Processing art work - Reference ISO Procedures LNPDA-P280 - Releasing Approved
Packaging Art to Purchasing, LNPDA-P285 - Releasing Approved Packaging Art to Plants 08, 80, 90. See
Chapter 6 in Design manual.
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HARD DRIVE:
Partitiion HD into 3 drives. Mac OS Extended Install OS 9 Driver
Macintosh HD 40%
Working HD 45%
Windows HD 15% (Virtual PC if needed)
OSX and OS 9 systems must be installed. (Password should be leviton)

A Second HD will be backup.
Macintosh Backup HD an Emergency start-up system should be installed
Working Backup HD
Windows Backup HD

SOFTWARE:
Photoshop CS Pagemaker 6.5 Barcode Pro 6.05
Illustrator CS Quark 6 Eye Candy 4000
Cadtools in Illustrotor 8 or 9 Flightcheck 5.5 Xenofex 2
Acrobat 7 & Distiller 5 Fetch 4.0 (set up FTP) TechTools 4
Indesign CS Microsoft Office 2004 Toast
Stuffit Deluxe 9 Virtual PC7 (selected computers) Virex

FONTS:
FontAgent Library copy to Macintosh HD
ATM extension in OS 9 (In control Panels)
Delete all fonts in the OS 9 system folder that are not city names.
Extensis Suitcase X1
FontDoctor X

NETWORK:
Must advert the corp. Firewall.
Microsoft Outlook 2001 (Set up Email)
Citrix ICA Client
Retrospect (Set up Work folder back up)

Old System to New System:
Copy over Music / Pictures folders
Library folder go to the preferences & copy over Safari/Explorer folders
Copy over Outlook personel folders

PRINTER DRIVERS:
(Copy over Printer Descriptions in the Extensions Folder)
HP 5100 Canon Edox
HP 4V Adobe PS 8.8

Fonts for Start-Up in Suitcase
Formata Garamond
Futura Goudy
Franklin Gothic Eras
Zapf Dingbats Myriad
OCR-A BarCode Pro Wingdings
OCR-B BarCode Pro Helvetica
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Desktop Appearance

In order to maintain consistency throughout the department we are instituting a procedure for Workstation Desktops. I
have included snapshots of examples of what your desktop should look like. As far as a desktop pattern, there is no
standard, you may still use photographs.

In the upper left corner you should have 2 folders, WORK IN PROGRESS and WORK COMPLETE. These folders are
created from your Macintosh HD.

The WORK IN PROGRESS folder contains your artwork that is currently active. This is
work that is still in progress, waiting for approval and work that is completed and ready
for release. Folders within your WORK IN PROGRESS folder are categorized as
follows; by Cat No., this would be the Ref. Cat. No. on the Art Request Folder or by
Project XXXXX, this would be the Project Name on the Art Request Folder. You will use
a Project XXXXX folder when there are many folders associated with one project.
Sometimes these folders are distributed amongst several artists. There are color
designations which will represent what stages the artwork is in. BLUE represents work
in progress, YELLOW represents work in the approval stage, GREEN represents work
that has been approved and is ready for release and RED represents artwork that is on
hold. Often at times we are given artwork without a folder so you will create a NON
PAK-TRAK PROJECTS folder for these files within your WORK IN PROGRESS folder,
the color designation is PURPLE. Once you receive a folder for this artwork you will
refile and rename in the appropriate folder. Your section tabs where your folders are
located at your workstations are color coded to match the folders in your WORK IN
PROGRESS.

The WORK COMPLETE folder contains artwork that you have completed and already
backed up to the PDP SERVER. This serves as a back-up of the work you have
completed in case there is a problem with the files already transferred to the PDP
SERVER. The structure of this folder mirrors the structure of the PDP SERVER.

Your desktop should be clear of all other files and should only contain your Volumes
(Hard Drives) and Desktop Printers.
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2Packaging Design

Meatball band ratio guidlines. Use this as a guide when determining sizes for packaging componets.
Note: There are exceptions to the rule and product line templates should always be used first.
Templates can be found on the Packaging Services Graphics folder.

1.50"

.222"
0.75"

2.25"

.332"

1.12"

3.00"

.443"
1.50"

74°


74°


74°
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LISTED

ADAPTER


261B

UL®


Agency Logo Sequence SpecsAgency Logo Sequence Specs

Recycle Symbol SpecsRecycle Symbol Specs

The size of the CSA, NOM and ANCE logos should not be larger than the circle that surrounds the UL logo.
The copy on four element listings do not count for sizing reference. See Guide lines (     ).

Left to Right and Top to Bottom Layout:

UL, CSA, NOM, ANCE    Examples:

The recycle logo should be placed in the same spot for all artwork unless there is an issue with space.
Location should be next to the COO, “Made in...”

Example:

LISTED

ADAPTER


261B

UL®


Stacked as Two Rows:

UL, CSA - Top Row
NOM, ANCE - Bottom Row    Example:

LISTED

ADAPTER


261B

UL®


Note: The registered mark ® on the UL logo is not necessary when it is to small to be readable.

Manufactured and Exported For / Manufacturado y Exportado Para:
Leviton Mfg. Co., Inc. 59-25 Little Neck Parkway, Little Neck, N.Y. 11362-2591 
Imported For / Importado Para: Leviton, S. de R. L. de C.V., Lago Tana 
No. 43 Col. Huichapan. Del. M. Hidalgo México D. F., México. CP 11290 Tel (55) 5082-1040
Made in U.S.A. / Hecho en EE.UU.
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 IMPORTANT: THIS IS A “GENERAL” CARD TEMPLATE. ART & TEXT ATTRIBUTES MAY HAVE TO BE ADJUSTED
 DEPENDING ON THE SIZE OF THE BLISTER PACK AND/OR PRODUCT. 

 1 COLOR: BACKGROUND - PANTONE 2935 C 

 2 COLOR: LEVITON BACW LOGO - WHITE

 3 COLOR / FONT: ENGLISH DESC. - WHITE / FORMATA BOLD COND. 13PT. (HORIZ. SCALED IF NEEDED)

 4 COLOR: MEATBALL, HORIZONTAL BAND AND CAT. NO. OVAL - PANTONE 2935 C @ 65% 

 5 COLOR / FONT: DESCRIPTION TEXT - WHITE / HELVETICA BOLD COND. 10PT OVER 11PT.

 6 PLACE APPROPRIATE TRIMATRON AND APPLICATION & FEATURE ICON(S) TO FIT HERE.

 7 PLACE APPROPRIATE COLOR PHOTO FOR KNOB (PUSH DIMMER VERSION ONLY). 

 8 COLOR / FONT: “COLOR” & “Free knob included” text - BLACK / HELVETICA HEAVY & REGULAR 11PT. & 10 OVER 11PT. 

 9 COLOR / FONT: “No. CAT.” & “Color” OVAL TEXT - WHITE / HELVETICA BOLD 7.5PT. & 8.5PT. 

10 PLACE STANDARD BARCODE FOR CD AND CI (UPC (A).General.EPS) HERE WITH SAN-CAT-DASH ABOVE / HELV REG. 6PT.

         
CENTER UPC AND TEXT IN WHITE RECTANGLE .937"x 1.75".

11 COLOR / FONT: DESCRIPTION TEXT (BACK PANEL) - WHITE / HELVETICA BOLD 9PT. OVER 9PT. 
         RATING / FEATURES - WHITE / HELVETICA REGULAR 9PT. OVER 10PT.
           ADDITIONAL COPY - WHITE / HELVETICA REGULAR 9PT. OVER 10PT.
           IMPORT/EXPORT STATEMENT & COUNTRY OF ORIGIN - 1ST LINE HELV. BOLD - THE REST HELV. REG. 6PT. OVER 7PT.

12 COLOR / FONT: “ENERGY SAVINGS” text - PANTONE 123 C / HELVETICA BOLD 11PT.; HORIZ. SCALE 130%

13 COLOR / FONT: “ENERGY CHART” text - WHITE / FORMATA REGULAR 8PT. OVER 9PT.

14 COLOR / FONT: FILENAME AND PK# text - WHITE / HELVETICA REGULAR 5.5PT. & 4.5PT.

15 PLACE APPROPRIATE AGENCY LOGOS TO FIT HERE / WHITE.

16 COLOR / FONT: PRODUCT INFO HOTLINE & ISTALL. INSTRUCT. ENCLOSED BOXES text - WHITE / HELVETICA CONDENSED
 6PT. OVER 8PT. / .5PT. RULE FOR BOXES.

CI SMALL Template - Lighting Controls

TRIMATRON LOGO

Import / Export Statement
Import/export information
and addresses.
Country of Origin

Lighted Push Dimmer

C
I-X

X
X

-X
X

X
X

X
-X

X
X

 / P
K

-X
X

X
X

X
-X

X
-X

X
-X

X

OR

Item Description

Ratings

• Features 

1.404" 1.375" 1.469"

0.219"

2.187"

4.437"

4.469"

2.625"

0.1875R

Item Description
APPLICATION

ICON
(i.e.

SINGLE POLE,
3-WAY)

APPLICATION
ICON
(i.e.

SINGLE POLE,
3-WAY)

LIGHT BULB
ICON WITH
WATTAGE

FEATURE ICON
HERE WHEN 
INDICATED

(i.e. locator light)

“INCANDESCENT”

No. CAT Color

“COL OR”
Free

knob
included

Features
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Additional Copy
Additional Copy
Additional Copy

B
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XXX

XX
X-

XX
XX

-X
X

AGENCY
LISTINGS

AGENCY
LISTINGS

1

3

4

2

15 410121314 11
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 IMPORTANT: THIS IS A "GENERAL" CARD TEMPLATE. ART & TEXT ATTRIBUTES MAY HAVE TO BE ADJUSTED 
 DEPENDING ON THE SIZE OF THE BLISTER PACK AND/OR PRODUCT.  

 1 COLOR: BACKGROUND - PANTONE 2935 CV  

 2 COLOR: LEVITON BACW LOGO - WHITE 

 3 COLOR/FONT: ENGLISH DESC. - WHITE/FORMATA BOLD COND. 18PT OVER 22PT. (HORIZ. SCALED IF NEEDED) 

 4 COLOR: MEATBALL AND HORIZONTAL/VERTICAL CORNER BAND VARIES ACCORDING TO PRODUCT CATEGORY 

 5 DECORA LOGO WITH PRODUCT CATEGORY (I.E. DECORA SURESLIDE) 

 6 ICON ART (I.E. SINGLE POLE ICON OR LIGHT BULB, FAN ICON) 

 7 STANDARD DECORA CELL COPY 

 8 COLOR/FONT: ADDITIONAL CELL COPY - WHITE/HELV. NEUE. 45 LIGHT 9PT OVER 10PT. 

 9 COLOR: 1/8 TH INCH BLEED OF BACKGOUND PANTONE 2935 CV 

10 COLOR/FONT: ENERGY SAVINGS - PMS 123/HELVETICA 75 BOLD 12 PT. HORIZONTAL SCALE 130% 

11 COLOR/FONT: PRODUCT INFORMATION HOTLINE BOX - WHITE/HELVETICA BOLD 7PT. OVER 8PT. 

12 COLOR/FONT: ITEM NUMBER TEXT - WHITE B.HELVETICA BOLD 8.4PT. 

13 COLOR/FONT: TEXT CATEGORY COLOR - 75 HELVETICA BOLD 11.5PT., CIRCLE IS WHITE UNLESS ALMOND 

14 COLOR/FONT: ENGLISH FEATURE - PANTONE 123 CV/HELVETICA COND. BOLD 16PT OVER 20PT. (HORIZ. SCALED IF NEEDED) 

Decora CI Template - Lighting Controls

5.719" 

3.281" 

1.375" 

2.656" 

R .220" 

6.130" 

2.623" 

1.938" 1.750" 1.938" 
.50" 

No. CAT 

1 

3 
14 

2 

English Description extended descr. 
Features 

Wallplate sold separately 

E
N

E
R

G
Y

 S
A

V
IN

G
S

 

EN
ER

G
Y SAVIN

G
S 

C
H

A
R

T 

12 13 

5 

6 

.125" 

9 7 8 

10 

11 

Additional Copy 
Additional Copy 
Additional Copy 

Additional Copy 
Additional Copy 
Additional Copy 

PRODUCT 
LINE 
ART 

UPSELL PRODUCT 
PHOTOS 

Product 
line art 
call outs 

Use with                    wallplate.   
See the full line of Decora devices 
and lighting controls including 
switches, outlets, GFCI’s,   
dimmers and fan controls. 
 
 
 
 
  
 
 

 
Decora replaces standard 
devices and adds a decorative 
touch to any décor. 

Pr
od

uc
t I

nf
or

m
at

io
n 

H
ot

lin
e 

B
ox

 

APPLICATION 
ICON 

 
SINGLE POLE, 

3 WAY 

LIGHT BULB 
ICON, 

FAN ICON 

Color 

DECORA 
LIGHTING CONTROL 

CATEGORY 

4 
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English Description 
Extended Description 

PROGRADE, DECORA, ETC. 
LOGOS WHEN INDICATED 

SIZE OF PHOTO 
SHOULD BE AS 

LARGE AS 
POSSIBLE 
AND MAY 

EXCEED THE 
INDICATED 

AREA WHENEVER 
POSSIBLE 

LL-XXX-XXXXX-XXX 

CSA, 
NOM/ANCE LOGOS 

HERE WHEN INDICATED 

1 

3 

4 

5 

6 

2 

7 9 8 

LL Template - 4 Inch Low Lip Rak Pak Label - Lighting Controls 

No. CAT Color 

APPLICATION 
ICON 

 
SINGLE POLE, 

3 WAY 

 1 COLOR: BACKGROUND - PANTONE 2935 CV 

 2 COLOR: LEVITON BACW LOGO - WHITE

 3 COLOR/FONT: CATEGORY TEXT - WHITE/FORMATA BOLD COND. 14PT OVER 18PT. (WIDTH 85% SCALE)

 4 COLOR: MEATBALL AND HORIZONTAL RULE VARIES ACCORDING TO PRODUCT CATEGORY

 5 COLOR/FONT: DESCRIPTION TEXT  - WHITE/HELVETICA BOLD COND. 15PT OVER 19PT.

 6 COLOR/FONT: ITEM NUMBER TEXT - WHITE HELVETICA BOLD 13PT.

 7 COLOR/POSITION: 1/8TH INCH FROM ITEM NUMBER TEXT (WHEN POSSIBLE)

 8 COLOR: 1/8xTH INCH BLEED OF BACKGOUND PANTONE 2935 CV

 9 COLOR/FONT: SAN NUMBER TEXT WHITE/HELVETICA REG. 6PT. (MAY ROTATE HORIZONTAL IF NEEDED)

10 LOGOS

3.750" 

2.250" 

10 
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ROTARY & 

TOGGLE DIMMERS

(except Fan Speed Controls)


Trimatrons@65%


FAN

SPEED


CONTROLS

FAN/

LIGHT


CONTROLS

TRIMATRON

(Low End)

20% Black

LIGHTING CONTROLS



Sureslide



Illumatech

SLIDE DIMMERS



Toggletouch



True Touch
Scene


Selector
Touch

Point

TOUCH DIMMERS



Mural@78%

ROCKER

DIMMERS 


Sensors

Motion

Activated

PMS

3135

PMS

132

PMS

130

PMS

2935

PMS

569

PMS

718

BLACK

PMS

3135

PMS

2622

PMS

2622

PMS

2622

PMS

2622

ROTARY & 
TOGGLE DIMMERS
(except Fan Speed Controls)

Trimatrons@65%

FAN
SPEED

CONTROLS

FAN/
LIGHT

CONTROLS VIZIA

LIGHTING CONTROLS (ED Box Colors)

Sureslide Illumatech

SLIDE DIMMERS

Toggletouch True Touch
Scene

Selector
Touch
Point

TOUCH DIMMERS

Mural@78%

ROCKER
DIMMERS

Sensors

Motion
Activated

PMS
278

CMYK

PMS
3135

CMYK

PMS
130

CMYK

PMS
3248

CMYK

PMS
2622

CMYK

PMS
186

CMYK

Each category has it’s own assigned color please follow the above charts.
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 IMPORTANT: THIS IS A "GENERAL" CARD TEMPLATE. ART & TEXT ATTRIBUTES MAY HAVE TO BE ADJUSTED 
 DEPENDING ON THE SIZE OF THE BLISTER PACK AND/OR PRODUCT.  

 1 COLOR: BACKGROUND - PANTONE 2935 CV  

 2 COLOR: LEVITON BACW LOGO - WHITE 

 3 COLOR/FONT: ENGLISH DESC. - WHITE/FORMATA BOLD COND. 18PT OVER 22PT. (HORIZ. SCALED IF NEEDED) 

 4 COLOR: MEATBALL AND HORIZONTAL/VERTICAL CORNER BAND VARIES ACCORDING TO PRODUCT CATEGORY 

 5 DECORA LOGO WITH PRODUCT CATEGORY (I.E. DECORA SURESLIDE) 

 6 ICON ART (I.E. SINGLE POLE ICON OR LIGHT BULB, FAN ICON) 

 7 STANDARD DECORA CELL COPY 

 8 COLOR/FONT: ADDITIONAL CELL COPY - WHITE/HELV. NEUE. 45 LIGHT 9PT OVER 10PT. 

 9 COLOR: 1/8 TH INCH BLEED OF BACKGOUND PANTONE 2935 CV 

10 COLOR/FONT: ENERGY SAVINGS - PMS 123/HELVETICA 75 BOLD 12 PT. HORIZONTAL SCALE 130% 

11 COLOR/FONT: PRODUCT INFORMATION HOTLINE BOX - WHITE/HELVETICA BOLD 7PT. OVER 8PT. 

12 COLOR/FONT: ITEM NUMBER TEXT - WHITE B.HELVETICA BOLD 8.4PT. 

13 COLOR/FONT: TEXT CATEGORY COLOR - 75 HELVETICA BOLD 11.5PT., CIRCLE IS WHITE UNLESS ALMOND 

14 COLOR/FONT: ENGLISH FEATURE - PANTONE 123 CV/HELVETICA COND. BOLD 16PT OVER 20PT. (HORIZ. SCALED IF NEEDED) 

Decora CI Template - Lighting Controls

5.719" 

3.281" 

1.375" 

2.656" 

R .220" 

6.130" 

2.623" 

1.938" 1.750" 1.938" 
.50" 

No. CAT 

1 

3 
14 

2 

English Description extended descr. 
Features 

Wallplate sold separately 

E
N

E
R

G
Y

 S
A

V
IN

G
S

 

EN
ER

G
Y SAVIN

G
S 

C
H

A
R

T 

12 13 

5 

6 

.125" 

9 7 8 

10 

11 

Additional Copy 
Additional Copy 
Additional Copy 

Additional Copy 
Additional Copy 
Additional Copy 

PRODUCT 
LINE 
ART 

UPSELL PRODUCT 
PHOTOS 

Product 
line art 
call outs 

Use with                    wallplate.   
See the full line of Decora devices 
and lighting controls including 
switches, outlets, GFCI’s,   
dimmers and fan controls. 
 
 
 
 
  
 
 

 
Decora replaces standard 
devices and adds a decorative 
touch to any décor. 

Pr
od

uc
t I

nf
or

m
at

io
n 

H
ot

lin
e 

B
ox

 

APPLICATION 
ICON 

 
SINGLE POLE, 

3 WAY 

LIGHT BULB 
ICON, 

FAN ICON 

Color 

DECORA 
LIGHTING CONTROL 

CATEGORY 

4 

GREEN
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English Description 
Extended Description 

PROGRADE, DECORA, ETC. 
LOGOS WHEN INDICATED 

SIZE OF PHOTO 
SHOULD BE AS 

LARGE AS 
POSSIBLE 
AND MAY 

EXCEED THE 
INDICATED 

AREA WHENEVER 
POSSIBLE 

LL-XXX-XXXXX-XXX 

CSA, 
NOM/ANCE LOGOS 

HERE WHEN INDICATED 

1 

3 

4 

5 

6 

2 

7 9 8 

LL Template - 4 Inch Low Lip Rak Pak Label - Lighting Controls 

No. CAT Color 

APPLICATION 
ICON 

 
SINGLE POLE, 

3 WAY 

 1 COLOR: BACKGROUND - PANTONE 2935 CV 

 2 COLOR: LEVITON BACW LOGO - WHITE

 3 COLOR/FONT: CATEGORY TEXT - WHITE/FORMATA BOLD COND. 14PT OVER 18PT. (WIDTH 85% SCALE)

 4 COLOR: MEATBALL AND HORIZONTAL RULE VARIES ACCORDING TO PRODUCT CATEGORY

 5 COLOR/FONT: DESCRIPTION TEXT  - WHITE/HELVETICA BOLD COND. 15PT OVER 19PT.

 6 COLOR/FONT: ITEM NUMBER TEXT - WHITE HELVETICA BOLD 13PT.

 7 COLOR/POSITION: 1/8TH INCH FROM ITEM NUMBER TEXT (WHEN POSSIBLE)

 8 COLOR: 1/8xTH INCH BLEED OF BACKGOUND PANTONE 2935 CV

 9 COLOR/FONT: SAN NUMBER TEXT WHITE/HELVETICA REG. 6PT. (MAY ROTATE HORIZONTAL IF NEEDED)

10 LOGOS

3.750" 

2.250" 

10 

GREEN
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DECORA 
Lighting Controls CI

w/Wallplate



ackaging

esign and

rocurement






PACKAGING DESIGN MANUAL
Packaging Design

17

DECORA
Lighting Controls CI

Small
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DECORA Retail
Multi-Pack Box
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IMPORTANT: THIS IS A "GENERAL" MULTIPACK BOX TEMPLATE. ART & TEXT ATTRIBUTES
MAY HAVE TO BE ADJUSTED DEPENDING ON THE SIZE OF THE BOX AND/OR PRODUCT. 

 1     COLOR: BACKGROUND - PMS 2935 C 

 2     COLOR: LEVITON BACW LOGO - WHITE

 3     COLOR: DECORA LOGO - WHITE / SWASH - PMS 117C (SCALE LOGO AS NEEDED)

 4     COLOR: MEATBALL AND HORIZONTAL/VERTICAL CORNER BAND (SEE TABLE 1)

 5     COLOR/FONT: ENG./FRENCH/SPANISH DESCRIPTION - WHITE/HELVETICA BOLD COND. 13PT

 6      COLOR/FONT: ENG./FRENCH/SPANISH DESCRIPTION - WHITE/HELVETICA BOLD COND. 15PT

 7     COLOR/FONT: CATEGORY DESCRIPTION - WHITE/FORMATA BOLD 16PT
        * LEAVE 1/8 SPACE BETWEEN END OF TEXT AND EDGE OF BAND.  LEAVE 3/32 SPACE 
          BETWEEN TOP OF TEXT AND CUT MARK

 8     COLOR: 1/8 TH INCH BLEED OF BACKGOUND PANTONE 2935 CV

 9     EP LABEL HERE. FIT TO SIZE. SEE EP LABEL SPECS FOR FURTHER INSTRUCTIONS.

To Open: Lift Tab and Pull / Pour Ouvrir : Lever la languette et tirer / Para Abrir: Levante la Lengüeta y Jale  

WARNING: USE THIS DEVICE ONLY WITH COPPER OR COPPER CLAD WIRE. WITH ALUMINUM WIRE
USE ONLY DEVICES MARKED CO/ALR OR CU/AL.

AVERTISSEMENT : N'UTILISER CE DISPOSITIF QU'AVEC DU FIL DE CUIVRE; EN PRÉSENCE DE FIL
D'ALUMINIUM, UTILISER SEULEMENT LES DISPOSITIFS PORTANT LA MARQUE CO/ALR OU CU/AL.

ADVERTENCIA: USE ESTE PRODUCTO SÓLO CON CABLE DE COBRE O REVESTIDO DE COBRE.  
PARA CABLE DE ALUMINIO USE SÓLO PRODUCTOS MARCADOS CON EL SÍMBOLO CO/ALR O CU/AL.

LB-XXX-XXXXX-XXX
PK-XXXXX-XX-XX-XX

ENGLISH DESCRIPTION
Rated: XXA-XXXV

TO INSTALL: 
WARNING: TO.... 

1. Helvetica medium, 9.5 pt. 11.4 leading....

 

Directives d’installation 
à l’intérieur

Instrucciones de 
instalación adentro 

de la caja

Q
T

Y
//Q

T
E

/C
A

N
T

S
A

N

X
X

X
X

X
-X

X

R
A

T
IN

G
S

 

C
A

T

C
O

LO
R

/C
O

U
LE

U
R

C
O

L
O

R
 E

N
G

L
IS

H
/

F
R

E
N

C
H

/S
P

A
N

IS
H

X
X

X

X
X

extended descr.

ENG. DESCR.
 

extended descr.

FRE. DESCR.
extended descr.

SPA. DESCR.

20.8438"

8.1875"

8.125" 8.125"
0.626"

4.3125"

1.9375"

1.9375"

2.000"

1.750"

AG
EN

C
Y LISTIN

G
S

A
N

D
 N

EM
A

IMPORT/EXPORT STATEMENT
COUNTRY OF ORIGIN

English Description
French Description
Spanish Description

English Description
French Description
Spanish Description

INSTRUCTION
DIAGRAMS

INSTALLATION INSTRUCTIONS

1
2

4

3

5

7
8

9

10 11
12

14 15 16 17

18
19

CANADA ONLY / CANADA SEULEMENT
Product Information Hotline:

Ligne d’assistance sur les produits
1 800 405-5320 / www.leviton.com

U.S.A. ONLY / Sólo en EE.UU.
Product Information Hotline:

Línea Automática de Información
1-800-824-3005 / www.leviton.com

13
CATAGORY  • FRENCH  • SPANISH

BA
R

C
O

D
E

6

Decora/ED Multi-Pack box
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Retail/ED Decora
Multi-Pack

Wallplate Boxes
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DECORA
Small Box
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Sell Copy Line 1 
Sell Copy Line 2
Sell Copy Line 3

CategoryPrimary Label 
Description

LL-XXX-XXXXX-XXX

X
X

X
X

-X

ICONS
HERE
WHEN

INDICATED

SIZE OF PHOTO
SHOULD BE AS

LARGE AS
POSSIBLE
AND MAY

EXCEED THE
INDICATED

AREA WHENEVER
POSSIBLE

C
O

L
O

R

ICONS HERE WHEN
ALTERNATIVE 

POSITION
IS NEEDED

XXXXX-XXXShelf Clearance

.941.054

Margin 3/16"
4 12 13

3
1

5

6

7

8

17

2

14

15
16

9 10 11

LL DECORA Template - 4" Rack Pack Label

 1 COLOR: PANTONE 235C

 2 COLOR/FONT: WHITE/FORMATA BOLD- 20 PT. TRACKING 15

 3 COLOR: MEATBALL 60% TINT OF PANTONE 235 C

 4 PRIMARY LABEL DECRIPTION - WHITE/FORMATA BOLD COND. 27PT

 5 SELL COPY LINE 1 - WHITE/FORMATA BOLD COND. 27PT OVER 25PT.

 6 SELL COPY LINE 2 - WHITE/FORMATA BOLD COND. 27PT OVER 25PT.

 7 SELL COPY LINE 3 - WHITE/FORMATA BOLD COND. 27PT OVER 25PT.

 8 ICON ART

 9 ICON ART ALTERNATIVE WHEN DESCRIPTION TAKES TO MUCH SPACE

10 PRODUCT PHOTO: COLOR CORRECTED EPS FILE

11 ITEM NUMBER FONT: HELVETICA 6PT.

12 DECORA LOGO - SCALED125% - PMS 123 CMYK

13 CATEGORY IE. SWITCH, OUTLET ETC.-FONT FORMATA BOLD 12PT.

14      COLOR OF PRODUC T CMYK BREAKDOWN

15      PART NUMBER FON T: HELVETICA 6PT.

16      1/8” BLEED

17 COLOR: LEVITON BACW LOGO - WHITE - SCALED 28%
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PMS
7494
C-23
Y-32
K-28

DECORA
Lighting Controls Colors Schemes for PMS 7494

PMS
5205
C-51
M-59
Y-38
K-2

PMS
5205
C-51
M-59
Y-38
K-2

SLIDE DIMMERS

PMS
7494
C-23
Y-32
K-28

ROTARY &
TOGGLE 

DIMMERS
Sureslide Illumatech Trimatrons

PMS
5425
C-45
M-5
K-39

SPECIALTY DIMMERS

Illumatech

(Except Fan Speed Controls)

Motion Activated
Sensors

PMS
465
C-27
M-33
Y-53

Fan Speed
Controls

(Except Fan Speed Controls)

PMS
5555
C-39
Y-31
K-38

PMS
5555
C-39
Y-31
K-38

PMS
5555
C-39
Y-31
K-38

PMS
5555
C-39
Y-31
K-38

TOUCH DIMMERS

Toggle Touch True Touch Scene Selector Touch Point

PMS
5555
C-39
Y-31
K-38

Vizia

ROTARY
DIMMERS

Solid background
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 IMPORTANT: THIS IS A "GENERAL" CARD TEMPLATE. ART & TEXT ATTRIBUTES MAY HAVE TO BE ADJUSTED
 DEPENDING ON THE SIZE OF THE BLISTER PACK AND / OR PRODUCT. 

 1    COLOR: BACKGROUND - PANTONE 2935 C 

 2    COLOR: LEVITON BACW LOGO - WHITE

 3    COLOR / FONT: ENGLISH DESC. - WHITE / FORMATA BOLD COND. 18PT OVER 22PT. (HORIZ. SCALED IF NEEDED)

 4    COLOR: MEATBALL AND HORIZONTAL / VERTICAL CORNER BAND: VARIES DEPENDING ON PRODUCT CATEGORY

 5    COLOR / FONT: DESCRIPTION TEXT  - WHITE / HELVETICA BOLD COND. 16PT OVER 17PT.

 6    COLOR / FONT: ADDITIONAL TEXT (IF NEEDED) - WHITE / HELVETICA BOLD COND. 7PT OVER 8PT

 7    COLOR / FONT: ITEM NUMBER TEXT - WHITE / HELVETICA COND. 9PT

 8    * USE ONLY IF ALMOND ITEM - COLOR: BLACK (CAN VARY DEPENDING ON CARD): 1/8" FROM ITEM NUMBER TEXT (WHEN POSSIBLE)

 9    COLOR: 1/8" BLEED OF BACKGROUND PANTONE 2935 C

10    COLOR / FONT: CATEGORY TEXT - WHITE / FORMATA BOLD COND. 16PT OVER AUTO TRACKED 35 (FORCE JUSTIFIED)

          
* LEAVE 1/8" SPACE BETWEEN END OF TEXT AND EDGE OF BAND.  LEAVE 3/32" SPACE BETWEEN TOP OF TEXT AND CUT MARK 

11    LOGOS

12    TYPE R4 IS THE STANDARD HANG HOLE USED FOR ALL CARDS UNLESS OTHERWISE NOTED.

E
n

g
l

i
s

h
C

a
t

 
•

 
S

p
a

n
i

s
h

C
a

tNo. XXXXX

11

8 9

3.625"

6.625"

Radius 0.125"

Spanish Description
English Description

1

3
4

Type R4 Hang Hole

5

7

6

2

10

12

.093"

.125"

0.625"

0.093"

DECORA, PROGRADE, 
COOL GLOW, ETC.

 LOGOS HERE
WHEN REQUIRED

• Eng. Additional Copy
• Eng. Additional Copy
• Eng. Additional Copy

• Spa. Additional Copy
• Spa. Additional Copy
• Spa. Additional Copy

Almond/Almendra

Walmart CD Card Template
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WIRING DEVICES WALMART CARDED

C    




          




          




         




         




         




         

 


       




       




       




             




       










Leviton

Blue

PMS

2935

PMS

284

PMS

234

PMS

252

PMS

166

PMS

355

PMS

187

PMS

375

PMS

3265

PMS

166

PMS

117



Heavy Duty/

Commercial

Battery

Operated

Electrical

Helper

Lamp

Accessory



Industrial



Residential



Decora

Night

Lights

Lamp

Repair



Protection

Each category has it’s own assigned color please follow the above chart.
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 IMPORTANT: THIS IS A “GENERAL” CARD TEMPLATE. ART & TEXT ATTRIBUTES MAY HAVE TO BE ADJUSTED
 DEPENDING ON THE SIZE OF THE BLISTER PACK AND/OR PRODUCT. 

 1 COLOR: BACKGROUND - PANTONE 2935 C 

 2 COLOR: LEVITON BACW LOGO - WHITE @ 24%

 3 COLOR / FONT: VERTICAL CATEGORY BAR - WHITE / FORMATA BOLD COND. U&LC 16PT. (TRACKING @ 100)

 4 COLOR: MEATBALL - PANTONE 234 C @ 100% 

 5 COLOR / FONT: DESCRIPTION TEXT - WHITE / HELVETICA BOLD COND. 13.5PT OVER 14PT.

 6 FINISHING TOUCH LOGO: PANTONE 123 C AND DROP SHADOW OF LOGO IN WHITE @ 75%.

FINISHING TOUCH Template 

1

"

"

Item Description
Spanish Description

D
e

c
o

r
a

t
i

v
e

 
•

 
D

e
c

o
r

a
t

i
v

a

5

3

6

2

4

6.625

6.8125
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XXA - XXXVSwitch

English Description
French Description
Spanish Description 

nControla la luz (luces) 
desde dos lugares

nCABLEADO LATERALo 
QUICKWIRE

MR

nCombinación triple de tornillos
Robertson/Phillips/ranurados 

XXA - XXXVAC/CA

3-Way

À trois voies
3 Vías

XXA - XXXVSwitch

English Description  
French Description   
Spanish Description   IV

O
R

Y

1 20V Switch

Manufactured and Exported By / Fabriqué et Exporté Par / Manufacturado y Exportado Por:
Leviton Mfg. Co., Inc. 59-25 Little Neck Parkway, Little Neck, N.Y. 11362-2591
La Manufacture Leviton du Canada Ltée / Leviton Mfg. of Canada Ltd.
165, Boul. Hymus Blvd., Pointe-Claire, Québec Canada, H9R 1E9
Imported For / Importé Pour / Importado Para: Leviton S. de R.L. de C. V., Lago Tana No. 43
Col. Huichapan, Del. M. Hidalgo México D. F., México. CP 11290 Tel (55) 5082-1040
Made in U.S.A. / Fabriqué aux É.-U. / Hecho en EE.UU.

U.S.A. ONLY / Sólo en EE.UU.
Product Information Hotline:

Línea Automática de Información
1-800-824-3005 / www.leviton.com

CANADA ONLY / CANADA SEULEMENT
Product Information Hotline:

Ligne d’assistance sur les produits
1 800 405-5320 / www.leviton.com

SB-M51-01453-20A
PK-98234-11-00-00

QTY/QTE/CANT

COLOR/COULEUR SAN

CAT

3-WAY SWITCH
INTERRUPTEUR
À 3 VOIES
INTERRUPTOR
DE 3 VIAS

IVORY / IVOIRE / MARFIL M01 15A-120V AC/CA

1453-2IM6

WARNING: TO BE INSTALLED AND/OR USED IN ACCORDANCE WITH APPROPRIATE ELECTRICAL CODES AND REGULATIONS.
WARNING: IF YOU ARE NOT SURE ABOUT ANY PART OF THESE INSTRUCTIONS, CONSULT A QUALIFIED ELECTRICIAN.
CAUTION: USE THIS DEVICE ONLY WITH COPPER OR COPPER CLAD WIRE. WITH ALUMINUM WIRE USE ONLY DEVICES
MARKED CO/ALR OR CU/AL.

TO INSTALL:
3-WAY SWITCH

RATED: 15A-120V AC

1. WARNING: TO AVOID FIRE, SHOCK, OR DEATH;
TURN OFF POWER AT CIRCUIT BREAKER OR FUSE
AND TEST THAT THE POWER IS OFF BEFORE
WIRING!

2. Remove insulation per strip gauge on device
[about 5/8" (1.6 cm)].

3. Connect wires per WIRING DIAGRAM as follows:
To Side Wire: Loop wires clockwise 3/4 turn around
terminal screws. Firmly tighten screws over wire loops.
Terminal screws accept up to #12 AWG copper or
copper clad wire.

To Quickwire™: Insert straight #14 AWG solid copper wires into round
Quickwire™ holes. Quickwire™ terminals accept #14 AWG solid copper
wires ONLY! For circuits with #12 AWG solid copper or copper clad wires,
use terminal screws instead. If the switch must be replaced or rewired
after Quickwiring, gently press the tip of a small screwdriver in the
release slot and back the wire out gradually. If the switch or
Quickwire™ terminal become damaged, do not reuse.

4. Mount device using long mounting screws. Attach
wallplate (not included).

5. Restore power at circuit breaker or fuse.
Installation is complete.

STRIP GAGE

5/8"
(1.6cm)

WIRING DIAGRAM

Directives
d’installation
à l’intérieur

Instrucciones
de instalación

adentro
de la caja

Hot (Black)

Neutral (White)

Load

Black

Line 120V AC, 60Hz

3-Way Switch 3-Way Switch

White Green Ground

Common Terminal
(Black Screw)

Common Terminal
(Black Screw)

M
51

No. 1453-2IM

nContrôle luminaire(s) à partir
de deux emplacements  

nCÂBLAGE LATÉRAL OU RAPIDE
(QUICKWIRE

MC
).

nVis à fente triple 
(Robertson/Phillips/droite)

nControls light(s) 
from two locations

nSIDEWIRE or QUICKWIRE
TM

nTriple combination screws 
Robertson/Phillips/Slotted

15A-120V Switch

3-Way 
Interrupteur à 3 Voies
Interruptor de 3 Vías

9

8 4 8 4

1

4

1 1

2

11

2

2

      C       

      C      

      C       

      C                  

      C        

       CO        

      C       

      C       
        * L                
          BE       

      C          

     E             

            
             

            

1

5
4

3

          

        

         

         

            

            

            

   

          

      

     

        

        

      COLOR OF PRODUCT  

      P     

      1/8” 

6

7

8

9

Home Depot Retail Multi-Pack Box
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To Open: Lift Tab and Pull / Pour Ouvrir : Lever la languette et tirer / Para Abrir: Levante la Lengüeta y Jale  

WARNING: USE THIS DEVICE ONLY WITH COPPER OR COPPER CLAD WIRE. WITH ALUMINUM WIRE
USE ONLY DEVICES MARKED CO/ALR OR CU/AL.

AVERTISSEMENT : N'UTILISER CE DISPOSITIF QU'AVEC DU FIL DE CUIVRE; EN PRÉSENCE DE FIL
D'ALUMINIUM, UTILISER SEULEMENT LES DISPOSITIFS PORTANT LA MARQUE CO/ALR OU CU/AL.

ADVERTENCIA: USE ESTE PRODUCTO SÓLO CON CABLE DE COBRE O REVESTIDO DE COBRE.  
PARA CABLE DE ALUMINIO USE SÓLO PRODUCTOS MARCADOS CON EL SÍMBOLO CO/ALR O CU/AL.

LB
-X

X
X

-X
X

X
X

X
-X

X
X

P
K

-X
X

X
X

X
-X

X
-X

X
-X

X

ENGLISH DESCRIPTION
Rated: XXA-XXXV

TO INSTALL: 
WARNING: TO.... 

1. Helvetica medium, 9.5 pt. 11.4 leading....

 

Directives d’installation 
à l’intérieur

Instrucciones de 
instalación adentro 

de la cajaQ
T

Y
//Q

T
E

/C
A

N
T

S
A

N

X
X

X
X

X
-X

X

R
A

T
IN

G
S

 

C
A

T

C
O

LO
R

/C
O

U
LE

U
R

C
O

L
O

R
 E

N
G

L
IS

H
/

F
R

E
N

C
H

/S
P

A
N

IS
H

X
X

X

X
X

ex
te

nd
ed

 d
es

cr
.

EN
G.

 D
ES

CR
.

 
ex

te
nd

ed
 d

es
cr

.

FR
E.

 D
ES

CR
.

ex
te

nd
ed

 d
es

cr
.

SP
A.

 D
ES

CR
.

20.8438"

8.1875"

8.125" 8.125"
0.626"

4.3125"

1.9375"

1.9375"

2.000"

1.750"

AG
EN

C
Y 

LI
ST

IN
G

S
A

N
D

 N
EM

A

IMPORT/EXPORT STATEMENT
COUNTRY OF ORIGIN

English Description
French Description
Spanish Description

INSTRUCTION
DIAGRAMS

INSTALLATION INSTRUCTIONS

1
2

4

3

5

7
8

9

10 11
12

14 15 16 17

18

CANADA ONLY / CANADA SEULEMENT
Product Information Hotline:

Ligne d’assistance sur les produits
1 800 405-5320 / www.leviton.com

U.S.A. ONLY / Sólo en EE.UU.
Product Information Hotline:

Línea Automática de Información
1-800-824-3005 / www.leviton.com

13
CATEGORY  • FRENCH  • SPANISH

19

BA
R

C
O

D
E

6 English Description
French Description
Spanish Description

PANEL 1

PANEL 4

PANEL 5 PANEL 6

PANEL 2

PANEL 3

ED Multi-Pack Wallplate Box
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XXXXX-XX (Color)

PROGRADE QUALITY

English Description 
Spanish Description 

X
X

X

XX-XXX-XXXXX-XXX
PK-XXXXX-XX-XX-XX

C
O

L
O

R

15A-125V

n Spanish - Bullet 1

n Spanish - Bullet 2 

Spanish - Bullet 3 

PROGRADE
Q U A L I T Y

PROGRADE
Q U A L I T YPROGRADE

Q U A L I T Y
PROGRADE

Q U A L I T Y

n English - Bullet 1

n English - Bullet 2 

English - Bullet 3 

For top performance and
extra durability choose
Leviton PROGRADE
commercial devices and
wallplates.

Para mejor
funcionamiento y mayor
duración, elija
productos y placas de
pared PROGRADE
de Leviton.

Outlet

English Description 
Spanish Description 

XXXXX-XX

15A-125VOutlet

XXX-XXXX-XX

Product Information Hotline
Línea Automática de Información

1-800-824-3005 / www.leviton.com

For terms and conditions
call 1-800-824-3005 or visit www.leviton.com

GARANTIA DE VIDA
Para términos y condiciones llame

al 1-800-824-3005 o visite nuestra página
www.leviton.com  

Country of Origin

Instrucciones de Instalación
dentro de la caja

Installation Instructions
On Inside of Box

PROGRADE QUALITY

Rating

n

PROGRADE
Q U A L I T Y

PROGRADE
Q U A L I T YPROGRADE

Q U A L I T Y
PROGRADE

Q U A L I T Y

n

For top performance and
extra durability choose
Leviton PROGRADE
commercial devices and
wallplates.

Para mejor
funcionamiento y mayor
duración, elija
productos y placas de
pared PROGRADE
de Leviton.

Category

RatingCategory

Product Information Hotline
Línea Automática de Información

1-800-824-3005 / www.leviton.com

For terms and conditions
call 1-800-824-3005 or visit www.leviton.com

GARANTIA DE VIDA
Para términos y condiciones llame

al 1-800-824-3005 o visite nuestra página
www.leviton.com  

Import/Export Statement 

Import/export information
and addresses

Instrucciones de Instalación
dentro de la caja

Installation Instructions
On Inside of Box

L I F E T I M E

AGENCY LISTINGS

C
E

L
O

C
E

L
O

2 1 3 4 5

6

7

8

10

9

12

11

Barcode

13

14

15

21

22

20

24

23

25

18

16

17

19

 1 COLOR / FONT: ENGLISH DESC. - WHITE / FORMATA BOLD COND. 15PT. (HORIZ. SCALED IF NEEDED)

 2 COLOR / FONT: SPANISH DESC. - WHITE / HELVETICA BOLD COND. 9PT. (HORIZ. SCALED IF NEEDED)

 3 COLOR / FONT: RATING - WHITE / FORMATA BOLD COND. 16.5PT. - HORIZ. SCALED 83%

 4 PROGRADE LOGO - FONT: FRANKLIN GOTHIC HEAVY OBLIQUE 10.87PT. - TRACKING -30, PMS 123

 5 COLOR / FONT: CATEGORY - WHITE / FORMATA BOLD COND. 12PT. - HORIZ. SCALE 83%

 6 COLOR/FONT: WHITE/FORMATA BOLD- 14 PT. TRACKING 175 - HORIZ. SCALE 120%

 7 PROGRADE LOGO - FONT: FRANKLIN GOTHIC HEAVY OBLIQUE 15PT. - TRACKING -30, PMS 123

 8 COLOR / FONT: BULLETED COPY - WHITE / HELVETICA MEDIUM COND. 8.7PT. OVER 10.44PT. 

 9 COLOR: BACKGROUND - STEEL-MEATBALL TALL (2935).DCS

10 COLOR / FONT: “No. CAT.” & “Color” OVAL TEXT - WHITE / HELVETICA BOLD 7.5PT. & 8.5PT.

               

                 

         
        

              

               

         

                 
        

                
           

        

       

                 

                

               

            

            

                       

                   

                 

         
C         

                
                   
           ADDITIONAL         
           IMPOR                   
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PROGRADE Retail
Multi-Pack Box
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PROGRADE Wallplate
Multi-Pack Box
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Sell Copy Line 1 
Sell Copy Line 2
Sell Copy Line 3

CategoryPrimary Label 
Description

LL-XXX-XXXXX-XXX

ICONS
HERE
WHEN

INDICATED

SIZE OF PHOTO
SHOULD BE AS

LARGE AS
POSSIBLE
AND MAY

EXCEED THE
INDICATED

AREA WHENEVER
POSSIBLE

C
O

L
O

R

ICONS HERE WHEN
ALTERNATIVE 

POSITION
IS NEEDED

XXXXX-XXX

PROGRADE
Q U A L I T Y

Shelf Clearance

.941.054

Margin 3/16"

LL PROGRADE Template - 4" Rack Pack Label

 1 COLOR: LEVITON BACW LOGO - WHITE - SCALED 28%

 2 COLOR/FONT: WHITE/FORMATA BOLD- 20 PT. TRACKING 15

 3 COLOR: MEATBALL 80% TINT OF PANTONE 235 C

 4 PRIMARY LABEL DECRIPTION - WHITE/FORMATA BOLD COND. 27PT

 5 SELL COPY LINE 1 - WHITE/FORMATA BOLD COND. 27PT OVER 25PT.

 6 SELL COPY LINE 2 - WHITE/FORMATA BOLD COND. 27PT OVER 25PT.

 7 SELL COPY LINE 3 - WHITE/FORMATA BOLD COND. 27PT OVER 25PT.

 8 ICON ART

 9 ICON ART ALTERNATIVE WHEN DESCRIPTION TAKES TO MUCH SPACE

10 PRODUCT PHOTO: COLOR CORRECTED EPS FILE

11 ITEM NUMBER FONT: HELVETICA 6PT.

12 PROGRADE LOGO - FONT: FRANKLIN GOTHIC HE AVY OBLIQUE 21.5PT.- PMS 123 CMYK

13 CATEGORY IE. SWITCH, OUTLET ETC.-FONT FORMATA BOLD 12PT.

14      PART NUMBER FONT: HELVETICA 6PT.

15      1/8” BLEED

4 12 13

2

11109
15

14

1

8

7

6

5

3
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WIRING DEVICES
DEPOT LABEL COLORS

DECORA COLORS

Adapters

PMS
152

PMS
284

PMS
2935

PMS
123

PMS
187

Wallplates Outlets/
Switches

PMS
2935

@55%

Band Highlight
color

Lamp Parts/
Plugs Connectors

DECORA

PMS
235

PMS
355

C5-M3-Y5 40% Black C15-M13
Y32-B1

C11-M9-Y20

GFCI
Protection

White Gray Ivory Almond

Each category has it’s own assigned color please follow the above chart.

PROGRADE
Wallplates

PROGRADE

PMS
284

PMS
2935
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 1 FILL: 25% PMS COOL GRAY 11C
 RULE: 100% COOL GRAY 11C - .5PT 
 FONT: (FOR TEXT) TIMES-7PT OVER 7.5PT

 2 FONT: TIMES-9.5PT/PMS COOL GRAY 11C/TRACK:100 

 3 RULE:.25PT/PMS COOL GRAY 11C

 4 FONT: TIMES-7PT/PMS COOL GRAY 11C/TRACK:56

 5 VARIABLE INFO:
 FONT: (LINE 1) HELVETICA-7PT/PMS COOL GRAY 11C
 FONT: (LINE 2) HELVETICA-6PT/PMS COOL GRAY 11C

 6 ACENTI LOGO: PMS 2935 & K - 90%

 7 FONT: HELV.- BOL. OBL. - 5.5PT OVER 4PT

 8 FILL: 25% PMS COOL GRAY 11C
 RULE: 100% COOL GRAY 11C - .5PT 
 FONT: (FOR TEXT) TIMES-11PT/TRACK:62

 9 FONT: TIMES-11PT/PMS COOL GRAY 11C/TRACK:40

10 FONT: TIMES-9.5PT/PMS COOL GRAY 11C/TRACK:100

11 RULE:.25PT/PMS COOL GRAY 11C

12 FONT: TIMES-7PT/PMS COOL GRAY 11C/TRACK:42

13 FONT: HELV.-5PT OVER 5.5PT/PMS COOL GRAY 11C

14      RULE: 100% COOL GRAY 11C - .44PT 
 FONT: (FOR TEXT) HELV. REG/BOLD-5.5PT OVER 6.5PT

15      RULE: 100% COOL GRAY 11C - .44PT 
 FONT: (FOR TEXT) HELV. REG/BOLD-5.5PT

16 FONT: HELV.-5PT OVER 5.5PT/PMS COOL GRAY 11C

17 LEVITON LOGO: COOL GRAY 11C - 14%

18 IMAGE: PMS 2935C FORGND-35%/BKGND-10%

19 RULE: 1PT/30% K
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Manufactured and Exported By / Fabriqué et exporté par /
Manufacturado y Exportado Por:
Leviton Mfg. Co., Inc. 59-25 Little Neck Parkway,
Little Neck, N.Y. 11362-2591
La Manufacture Leviton du Canada Ltée /
Leviton Mfg.of Canada Ltd.165, Boul. Hymus Blvd.,
Pointe-Claire, Québec Canada, H9R 1E9
Imported For / Importé pour / Impotado Para:
Leviton, S. de R. L. de C.V, Lago Tana 
No. 43 Col. Huichapan, Del. M. Hidalgo México 
D.F., México. CP11290 Tel (55) 5082-1040

Assembled in Mexico / Assemblé au Mexique /
Ensamblado en México

For technical assistance on 
Acenti products contact us at:

1-888-4-ACENTI (1-888-422-3684)
or visit us at:

www.leviton.com/acenti

Installation instructions enclosed
Directives d’installation à l’intérieur

Instrucciones de instalación incluidas.

U
.S. & Foreign Patents Pending
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eserved.

Brevets am
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T H E A C E N T I C O L L E C T I O N
D O W N T O T H E L A S T D E T A I L

L A C O L L E C T I O N A C E N T I
L A P E R F E C T I O N D A N S L E S M O I N D R E S D É T A I L S

C O L E C C I Ó N A C E N T I
P E R F E C C I Ó N H A S T A D E L Ú L T I M O D E T A L L E

D E S I G N E R W A L L P L A T E
P L A Q U E D E S I G N

P L A C A D E D I S E Ñ A D O R

• Fits all Acenti devices
• Alignment plate ensures precise device/wallplate

alignment in every installation.
• Elegant matte finish and perfect color match.
• Compatibilité avec tous les dispositifs Acenti.
• Mécanisme assurant un alignement dispositif/plaque précis.
• Élégant fini mat et harmonie parfaite des couleurs.
• Compatible con todos los productos Acenti
•La placa de alineamiento asegura el alineamiento preciso

del producto/placa en cada instalación
• Acabado mate elegante y combinación de color perfecto

Acenti 1-GANG Box {PK-98558-50-02-0A} Specs

1

2

10

3

11

4

12

8

18

9

17

7

5

6

13

19

15

14 IMPORT/EXPORT
 STATEMENT 

AND C.O.O. WILL VARY
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Acenti Box 2-GANG {PK-98559-50-02-0A} 

Same color specs apply  
for the 2 & 3 Gang boxes. 
(Ref. to 1-Gang) 
 
Please refer to templates  
located on the server for  
specific details on fonts,  
rules and image sizes. 

 

Acenti Box 3-GANG {PK-98560-50-02-0A} 
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L A P E R F E C T I O N D A N S L E S M O I N D R E S D É T A I L S

C O L E C C I Ó N A C E N T I
P E R F E C C I Ó N H A S T A D E L Ú L T I M O D E T A L L E

P
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P

K
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• Fits all Acenti devices
• Alignment plate ensures precise

device/wallplate alignment in
every installation.

• Elegant matte finish and 
perfect color match.

• Compatibilité avec tous les 
dispositifs Acenti.

• Mécanisme assurant un alignement
dispositif/plaque précis.

• Élégant fini mat et harmonie 
parfaite des couleurs.

• Compatible con todos los 
productos Acenti

•La placa de alineamiento asegura el
alineamiento preciso del producto/
placa en cada instalación

• Acabado mate elegante y 
combinación de color perfecto

U
.S. & Foreign Patents Pending
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opyright ©2004 Leviton M
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ress R
ights R

eserved.

Brevets am
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Manufactured and Exported By / Fabriqué et exporté par / 
Manufacturado y Exportado Por:
Leviton Mfg. Co., Inc. 59-25 Little Neck Parkway,
Little Neck, N.Y. 11362-2591
La Manufacture Leviton du Canada Ltée /
Leviton Mfg.of Canada Ltd.165, Boul. Hymus Blvd.,
Pointe-Claire, Québec Canada, H9R 1E9
Imported For / Importé pour / Impotado Para:
Leviton, S. de R. L. de C.V, Lago Tana 
No. 43 Col. Huichapan, Del. M. Hidalgo México 
D.F., México. CP11290 Tel (55) 5082-1040

Assembled in Mexico / Assemblé au Mexique / Ensamblado en México

For technical assistance on 
Acenti products contact us at:

1-888-4-ACENTI (1-888-422-3684)
or visit us at:

www.leviton.com/acenti

Installation instructions enclosed
Directives d’installation à l’intérieur

Instrucciones de instalación incluidas.
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3.000"1.500" 1.469"

1.750"
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9.593"
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1.062"

5.800"2.750" 10.056"

PK-98564-21-00-00

1.472"

T H E A C E N T I C O L L E C T I O N
D O W N T O T H E L A S T D E T A I L

L A C O L L E C T I O N A C E N T I
L A P E R F E C T I O N D A N S L E S M O I N D R E S D É T A I L S

C O L E C C I Ó N A C E N T I
P E R F E C C I Ó N H A S T A D E L Ú L T I M O D E T A L L E

PK-98564-31-62-1A
PK-98564-31-00-0A

• Fits into standard wall box.
• Alignment plate ensures precise device/

wallplate alignment in every installation.
• Elegant matte finish and perfect color match.
• Compatibilité avec les boîtes 

murales ordinaires.
• Mécanisme assurant un alignement 

dispositif/plaque précis.
• Élégant fini mat et harmonie parfaite 

des couleurs.
• Cabe en una caja de pared estándar
• La placa de alineamiento asegura el 

alineamiento preciso del producto/placa 
en cada instalación 

• Acabado mate elegante y combinación de
color perfecto. 
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U.S. & Foreign Patents Pending
Copyright© 2004 Leviton Manufacturing Co., Inc.
All Rights Including Trade Dress Rights Reserved

Brevets américains et étrangers en instance.
© 2004 Leviton Manufacturing Co., Inc. 
Tous droits réservés, y compris ceux de présentation.

Patentes pendientes de EE.UU. y Extranjeras
Copyright© 2004 Leviton Manufacturing Co., Inc.
Todos los Derechos Reservados Incluyendo
Derechos de Comercio

Manufactured and Exported By / Fabriqué et exporté par / Manufacturado y 
Exportado Por: Leviton Mfg. Co., Inc. 59-25 Little Neck Parkway, Little Neck, N.Y. 11362-2591
La Manufacture Leviton du Canada Ltée / Leviton Mfg. of Canada Ltd. 165, Boul. 
Hymus Blvd., Pointe-Claire, Québec Canada, H9R 1E9
Imported For / Importé pour / Impotado Para:
Leviton, S. de R. L. de C.V, Lago Tana No. 43 Col. Huichapan, Del. M. Hidalgo México 
D.F., México. CP 11290 Tel (55) 5082-1040

Assembled in Mexico / Assemblé au Mexique / Ensamblado en México

For technical assistance on 
Acenti products contact us at:

1-888-4-ACENTI (1-888-422-3684)
or visit us at:

www.leviton.com/acenti

All Acenti devices are covered by 
Leviton’s 5 Year Limited Warranty.

Tous les dispositifs Acenti sont appuyés par 
une garantie limitée de 5 ans de Leviton.

Todos los productos Acenti están cubiertos 
por 5 años de garantía limitada.

Installation instructions enclosed
Directives d’installation à l’intérieur

Instrucciones de instalación incluidas.

1

7

2

9

15

3

10

16

18

11

17

5

12

19

14
13

Acenti Device Box {PK-98564-21-02-0A} Specs

 1 ACENTI LOGO: PMS 2935 & K - 57%

 2 FILL: 25% PMS COOL GRAY 11C
 RULE: 100% COOL GRAY 11C - .5PT 
 FONT: (FOR TEXT) TIMES-8PT OVER 9PT

 3 FONT: HELV./ BLD OBL.-5.5PT OVER 7PT/PMS COOL GRAY 11C 

 4 RULE: 100% COOL GRAY 11C - .44PT 
 FONT: (FOR TEXT) HELV. REG/BOLD-5.5PT OVER 6.5PT

 5 LEVITON LOGO: COOL GRAY 11C - 17%

 6 FONT: HELV.-5PT OVER 5.5PT/PMS COOL GRAY 11C

 7 RULE: 1PT/30% K

 8 VARIABLE INFO:
 FONT: (LINE 1) HELVETICA-7PT/PMS COOL GRAY 11C
 FONT: (LINE 2) HELVETICA-6PT/PMS COOL GRAY 11C

 9 FONT: TIMES-8.5PT/PMS COOL GRAY 11C/TRACK:100 

10 RULE:.23PT/PMS COOL GRAY 11C

11  FONT: TIMES-6.5PT/PMS COOL GRAY 11C/TRACK:56

12 ACENTI LOGO: PMS 2935 & K - 80%

13 FILL: 25% PMS COOL GRAY 11C
 RULE: 100% COOL GRAY 11C - .5PT 
 FONT: (FOR TEXT) TIMES-10PT/TRACK:62

14 FONT: TIMES-10PT/PMS COOL GRAY 11C/TRACK:34

15 FONT: TIMES-8.5PT/PMS COOL GRAY 11C/TRACK:100

16 RULE:.25PT/PMS COOL GRAY 11C

17 FONT: TIMES-6.5PT/PMS COOL GRAY 11C/TRACK:49

18 IMAGE: PMS 2935C FORGND-35%/BKGND-10%

19 RULE: 1PT/30% K 

4

6

IMPORT/EXPORT STATEMENT 
AND C.O.O. WILL VARY

PART NUMBER WILL VARY
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Acenti Box DIMMER {PK-98567-21-02-1A} 

Same color specs apply  
for the Dimmer box  
(ref. to Device Box). 
 
Please refer to templates  
located on the server for  
specific details on fonts,  
rules and image sizes. 

0.625"

1.525"

2.75"

1.525"

11.55"

1.438"

5.800"

2.250" 3.000"

3.000"

0.625"

1.852"0.575" 0.575"

11.094"

PK-98567-31-00-0A

PK-98567-31-62-1A
PK-98567-31-00-0A

T H E A C E N T I C O L L E C T I O N
D O W N T O T H E L A S T D E T A I L

L A C O L L E C T I O N A C E N T I
L A P E R F E C T I O N D A N S L E S M O I N D R E S D É T A I L S
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U.S. & Foreign Patents Pending
Copyright© 2004 Leviton Manufacturing Co., Inc.
All Rights Including Trade Dress Rights Reserved

Brevets américains et étrangers en instance.
© 2004 Leviton Manufacturing Co., Inc. 
Tous droits réservés, y compris ceux de présentation.

Patentes pendientes de EE.UU. y Extranjeras
Copyright© 2004 Leviton Manufacturing Co., Inc.
Todos los Derechos Reservados Incluyendo
Derechos de Comercio

• Fits into standard wall box.
• Alignment plate ensures precise device/

wallplate alignment in every installation.
• Elegant matte finish and perfect color match.
• Compatibilité avec les boîtes 

murales ordinaires.
• Mécanisme assurant un alignement 

dispositif/plaque précis.
• Élégant fini mat et harmonie parfaite 

des couleurs.
• Cabe en una caja de pared estándar.
• La placa de alineamiento asegura el 

alineamiento preciso del producto/placa 
en cada instalación. 

• Acabado mate elegante y combinación de
color perfecto. 

Manufactured and Exported By / Fabriqué et exporté par / Manufacturado y 
Exportado Por: Leviton Mfg. Co., Inc. 59-25 Little Neck Parkway, Little Neck, N.Y. 11362-2591
La Manufacture Leviton du Canada Ltée / Leviton Mfg. of Canada Ltd. 165, Boul. 
Hymus Blvd., Pointe-Claire, Québec Canada, H9R 1E9
Imported For / Importé pour / Impotado Para:
Leviton, S. de R. L. de C.V, Lago Tana No. 43 Col. Huichapan, Del. M. Hidalgo México 
D.F., México. CP 11290 Tel (55) 5082-1040

Assembled in Mexico / Assemblé au Mexique / Ensamblado en México

For technical assistance on 
Acenti products contact us at:

1-888-4-ACENTI (1-888-422-3684)
or visit us at:

www.leviton.com/acenti

All Acenti devices are covered by 
Leviton’s 5 Year Limited Warranty.

Tous les dispositifs Acenti sont appuyés par 
une garantie limitée de 5 ans de Leviton.

Todos los productos Acenti están cubiertos 
por 5 años de garantía limitada.

Installation instructions enclosed
Directives d’installation à l’intérieur

Instrucciones de instalación incluidas.
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Acenti EP Label Specs

BARCODE HERE

SIZE OF
IMAGE

SHOULD
BE

APPROX
1" H

FONT: Times Semi Bold -10pt1

Acenti LOGO: 34.9%2

FONT: (For Description) Times Extra Bold -7pt over 7.5pt3

FONT: (For All Bullets) Times Semi Bold -7pt over 7.5pt4

IMAGE:  Height - approx. 1"5

RATING: Times Extra Bold -7pt6

AGENCY LOGOS:
- all codes should be approx. height of circle in UL CODE

7

FONT: (For San-Cat-Dash) Times Semi Bold -6pt8

BARCODE: Use current EP specs  
- change bar height to .375/change font size to 9pt

9

FONT: (For Part #) Helvetica - 4pt10

IMAGE: PMS2935 Forgnd-35%/Bkgnd-10%12

FONT: (For Multi Source) Helvetica - 4pt11

FONT: Times Semi Bold -10pt1

Acenti LOGO: 34.9%2

FONT: (For Description) Times Extra Bold -9pt over 8pt3

FONT: (For All Bullets) Times Semi Bold -8pt over 8pt4

IMAGE:  Height - approx. 1.02"5

AGENCY LOGOS:
- all codes should be approx. height of circle in UL CODE

6

FONT: (For San-Cat-Dash) Times Semi Bold -6pt7

FONT: (For Multi Source) Helvetica - 4pt

8 BARCODE: Use current EP specs  
- change bar height to .375/change font size to 9pt

9

RATING: Times Extra Bold -7pt10

IMAGE: PMS2935 Forgnd-35%/Bkgnd-10%12

FONT: (For Part #) Helvetica - 4pt11

Mid Atlantic Custom Label  2.907x2

DIMMER BOX - PK-92732-00-00-00

Mid Atlantic Custom Label  2.907x1.375

DEVICE BOX PK-92731-00-00-00

1.375"

2.907"

DESCRIPTION
• COLOR
DESCRIPTION FRENCH
• COLOR FRENCH
DESCRIPTION SPANISH
• COLOR SPANISH

XXXXX-X

XXX

X
X

X
-X

X
X

X
X

-X

E
P

-X
X

X
-X

X
X

X
X

-X
X

X

RATING

AGENCY LOGOS
HERE WHEN INDICATED

BA
RC

OD
E 

HE
RESIZE OF

IMAGE
SHOULD

BE
APPROX

1" H

12

3

4

5

6
7 8 9 10

1112

2.0"

2.907"

E
P

-X
X

X
-X

X
X

X
X

-X
X

X

DESCRIPTION 1
DESCRIPTION 2
• COLOR
DESCRIPTION FRENCH 1
DESCRIPTION FRENCH 2
• COLOR FRENCH
DESCRIPTION SPANISH 1
DESCRIPTION SPANISH 2
• COLOR SPANISH

XXXXX-XXX

X
X

X

RATING

XXX-XXXXX-XXX

12

3

4

5

6

7 10 11

12

AGENCY
LOGOS

HERE WHEN
INDICATED

8
9
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Acenti EP Label Specs

BARCODE HERE

SIZE OF
IMAGE

SHOULD
BE

APPROX
1" H

FONT: Times Semi Bold -10pt1

Acenti LOGO: 34.9%2

FONT: (For Description) Times Extra Bold -8pt over 8pt3

FONT: (For All Bullets) Times Semi Bold -8pt over 8pt4

IMAGE:  Height - approx. 1.02"5

AGENCY LOGOS:
- all codes should be approx. height of circle in UL CODE

6

FONT: (For San-Cat-Dash) Times Semi Bold -6pt7

FONT: (For Multi Source) Helvetica - 4pt

8 BARCODE: Use current EP specs  
- change bar height to .375/change font size to 9pt

9

FONT: (For Part #) Helvetica - 4pt10

IMAGE: PMS2935 Forgnd-35%/Bkgnd-10%11

FONT: Times Semi Bold -10pt1

Acenti LOGO: 34.9%2

FONT: (For Description) Times Extra Bold -8pt over 8pt3

FONT: (For All Bullets) Times Semi Bold -8pt over 8pt4

IMAGE:  Height - approx. .58”5

AGENCY LOGOS:
- all codes should be approx. height of circle in UL CODE

6

FONT: (For San-Cat-Dash) Times Semi Bold -6pt7

FONT: (For Multi Source) Helvetica - 4pt

8 BARCODE: Use current EP specs  
- change bar height to .375/change font size to 9pt

9

FONT: (For Part #) Helvetica - 4pt10

IMAGE: PMS2935 Forgnd-35%/Bkgnd-10%11
Mid Atlantic Label 1.875x3

WALLPLATE TEMPLATE - PK-92739-00-00-00
1,2,3 GANG

DEVICE TEMPLATE PK-92739-00-00-00

Mid Atlantic Label 1.875x3

XXX-XXXXX-XX

DESCRIPTION
• COLOR
DESCRIPTION FRENCH
• COLOR FRENCH
DESCRIPTION SPANISH
• COLOR SPANISH

XXXXX-X

E
P

-x
xx

-x
xx

xx
-x

xx

3.0"

1.875"

xx
x

12

3

4

5

6

7 10

11

8
9

AGENCY LOGOS
HERE WHEN
INDICATED

XXXXX-X

3.0"

1.875"

DESCRIPTION 1
DESCRIPTION 2
• COLOR
DESCRIPTION FRENCH 1
DESCRIPTION FRENCH 2
• COLOR FRENCH
DESCRIPTION SPANISH 1
DESCRIPTION SPANISH 2
• COLOR SPANISH

XXX-XXXXX-X

E
P

-X
X

X
-X

X
X

X
X

-X
X

X

X
X

X

BARCODE HERE

12
3

7 10

11

8
9

AGENCY
LOGOS

HERE WHEN
INDICATED

SIZE OF IMAGE
SHOULD

BE APPROX
.58" H

WIDTH WILL VARY

6

5

4
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Acenti EP Label Specs

4,5,6 GANG PK-92740-00-00-00

Mid Atlantic Label 4x2.5

4.0"

2.5"

E
P

-X
X

X
-X

X
X

X
X

-X
X

X

DESCRIPTION 1
DESCRIPTION 2
• COLOR

DESCRIPTION FRENCH 1
DESCRIPTION FRENCH 2
• COLOR FRENCH

DESCRIPTION SPANISH 1
DESCRIPTION SPANISH 2 
• COLOR SPANISH

XXXXX-X

X
X

X

12
3

4

10

11

9

SIZE OF IMAGE SHOULD
BE APPROX

.67" H
WIDTH WILL VARY

BARCODE HERE

AGENCY LOGOS
HERE WHEN
INDICATED6

7

XXX-XXXXX-X

8

5

1 FONT: (For Cat) Times Extra Bold -13pt

2 Acenti LOGO: 65%

3 FONT: (For Description 1 & 2) Times Extra Bold - 10pt over 10.5pt

4 FONT: (For All Bullets) Times Semi Bold - 10pt over 10.5pt

5 IMAGE:  Height - approx. .67"
- width will vary based on wallplate gang size

6

FONT: (For San-Cat-Dash) Times Semi Bold -6pt7

BARCODE: Use current EP specs  
- change bar height to .375/change font size to 9pt

8

FONT: (For Multi Source) Helvetica - 4pt9

FONT: (For Part #) Helvetica - 4pt10

IMAGE: PMS2935 Forgnd-35%/Bkgnd-10%11AGENCY LOGOS: at bottom left corner
- all codes should be approx. height of circle in UL CODE
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Acenti EP Label Specs

SIXPLEX - PK-92749-00-00-00

Mid Atlantic Label 4.5"x2"

BA
RC

OD
E 

HE
RE

1 FONT: (For Cat) Times Extra Bold -10pt 7 AGENCY LOGOS: at bottom left corner
- all codes should be approx. height of circle in UL CODE

2 Acenti LOGO: 44.5%

3 FONT: (For Description 1 & 2) Times Extra Bold - 8pt over 8pt

4 FONT: (For All Bullets) Times Semi Bold - 8pt over 8pt

FONT: (For Rating) Times Bold - 7.5pt over 8pt

5 IMAGE:  Height - approx. 1.5"
- width will vary based on wallplate gang size

6

E
P

-X
X

X
-A

X
X

X
X

X
-X

X
X

X
X

X
-X

X
X

X
X

-X

RATed: XX-XXXX AC/CA 

DESCRIPTION 1
DESCRIPTION 2
• COLOR

DESCRIPTION FRENCH 1 
DESCRIPTION FRENCH 2
• COLOR FRENCH

DESCRIPTION SPANISH 1
DESCRIPTION SPANISH 2
• COLOR SPANISH

XXXXX-X

XXX

SIZE OF IMAGE SHOULD
BE APPROX

1.5" H
WIDTH WILL VARY

AGENCY LOGOS
HERE WHEN
INDICATED

12
3

4 11

12

10
7 8 9

5

6

FONT: (For San-Cat-Dash) Times Semi Bold -6pt8

BARCODE: Use current EP specs  
- change bar height to .375/change font size to 9pt

9

FONT: (For Part #) Helvetica - 4pt10

FONT: (For Multi Source) Helvetica - 4pt11

IMAGE: PMS2935 Forgnd-35%/Bkgnd-10%12
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ACENTI BOX COLORS

PMS
2935

BLACK

Image & 
Acenti
logo

COOL 
GRAY 
11 C

Text and
gray boxes

D e s i g n e r P r o D u c t s

P r oDu i t s D e s i g n

IMAGE

FOREGROUND:
35% PMS 2935 

BACKGROUND:
10% PMS 2935 

LOGO

ACENTI:
40% BLACK

SWASH:
GRADIENT 

100% PMS 2935
TO 0% 

BY LEVITON:
100% BLACK

TEXT/BOX

TEXT/RULE:
100% COOL

GRAY 11

BOX FILL:
25% COOL
GRAY 11
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IMPORTANT: THIS IS A "GENERAL" INSERT TEMPLATE. ART & TEXT ATTRIBUTES MAY HAVE TO BE ADJUSTED
DEPENDING ON THE SIZE OF THE PRODUCT.

 1 COLOR: LEVITON BACW LOGO - WHITE - PLACE @ 22.8%

COLOR / FON T: PRODUCT LINE CATEGORY TEXT - WHITE / FORMATA BOLD COND. 14 PT. OVER 17 PT.

COLOR: MEATBALL AND HORIZONTAL BAR (SEE TABLE 1 FOR PROPORTIONS).

 2  

 3  

 4 COLOR / FONT: DESCRIPTION TEXT - WHITE / HELVETICA BOLD COND. 21 PT. OVER 19 PT. 

 5 COLOR / FONT: SECONDARY DESCRIPTION TEXT (IF NEEDED) WHITE / HELVETICA BOLD COND. 10 PT. OVER 13 PT.   

 6 COLOR / FONT: QTY NUMBER TEXT - WHITE W/BLK DROP SHADOW / FORMATA BOLD COND. 58 PT.

 7  COLOR / FONT: BLACK / CENTERED IN WHITE RECTANGLE BELOW QTY NUMBER SQUARE / FORMATA BOLD COND. / 
 P -25 PT.; ACK (small caps) -17 PT.

 8 PLACE APPROPRIATE PRODUCT CATEGORY ICON(S) @ 80%. IF MORE THAN ONE, PLACE VERTICALLY AS SHOWN.

THIS AREA IS FOR PRODUCT PHOTO AS LARGE AS FITS WITHIN BOXED AREA SHOWN. 9

10  COLOR / WHITE - AGENCY LOGOS IN THIS AREA AT APPROX. 10-18% OF ORIGINAL SIZE.

COLOR / FONT: DIVISION NAME - WHITE / FORMATA BOLD CONDENSED 10.5 PT.; 
PRODUCT SELL COPY - BLACK / FORMATA BOLD CONDENSED 10 PT.

COLOR / FONT / POSITION: WHITE / HELVETICA COND. 8.3 PT. / CATALOG NUMBER CENTERED IN COLORED RECTANGLE.

COLOR / FONT / POSITION: BLACK / HELVETICA COND. BOLD 8.3 PT. / COLOR CENTERED IN WHITE RECTANGLE.

COLOR / FONT / POSITION: WHITE / HELVETICA COND. 6 ON 5.7 PT. / SELL COPY FLUSH LEFT; .01" SPACE AFTER; TRACK AMOUNT -3.

COLOR / FONT / POSITION: WHITE / HELVETICA COND. 6 ON 5.7 PT. / INSTALL. INSTRUCTIONS FLUSH LEFT; .01" SPACE AFTER; TRACK AMOUNT -3 

PLACE UPC @ 100% / SAN-CAT-DASH TEXT ABOVE IT - HELVETICA COND. BOLD 5 PT.

COLOR / FONT / POSITION: MULTI-SOURCE SAN - BLACK / HELVETICA COND. BOLD 5 PT. / ROTATED 90 AND FLUSH WITH BOT TOM OF UPC NUMBERS.

COLOR / FONT / POSITION: BLACK / HELVETICA COMPRESSED / FLUSH LEFT - PART # ( 5 PT.) AND PK # (4 PT.); HORIZ. SCALE 120%.

COLOR / FONT: WHITE / HELVETICA REG. & HELV. BOLD 5 ON 5.5 PT. Manufactured and Exported By: & Country of Origin IN BOLD.

11     

12 

13 

14 

15 

16 

17 

18 

19 

3

1

6

2
4

9

5

16

18
17

15

19

14

8

1211

10

7

13

LIN Card Insert Template   
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LL
-X

X
X

-X
X

X
X

X
-X

X
X

3.750"

2.25"

1

LIN - LL Template - 3.75" x 2.25” Rack Pack Label

2

4

5

3

6

7

13

12

8 9 10
11

 1 COLOR: LEVITON BACW LOGO - WHITE - SCALE TO 23.5%

 2 COLOR / FONT: PRODUCT LINE CATEGORY TEXT - WHITE / FORMATA BOLD COND. 16 PT.

 3 COLOR / FONT: ITEM DESCRIPTION TEXT - WHITE / FORMATA BOLD COND. 19 ON 20 PT., -3 TRACKING

 4 COLOR: MEATBALL AND HORIZONTAL BAND (SEE TABLE 1) 100% TINT OF CATEGORY COLOR

 5 COLOR / FONT: SECONDARY DESCRIPTION TEXT (IF NEEDED) - WHITE / HELVETICA BOLD COND. 10 PT. 

 6 PLACE APPROPRIATE PRODUCT CATEGORY ICON(S) AS NEEDED - SCALE TO 50% 

 7 COLOR / FONT: DIVISION NAME - WHITE / FORMATA BOLD COND. CAPS 8 PT.;
 PRODUCT SELL COPY - BLACK / FORMATA BOLD COND. U&LC 7.2 PT.

 8  COLOR / FONT: CATALOG NUMBER CENTERED IN COLORED RECTANGLE - WHITE / HELVETICA COND. 6 PT. 

 9 COLOR / FONT: COLOR CENTERED IN COLORED RECTANGLE - BLACK / HELVETICA COND. 6 PT.

10 PRODUCT PHOTO: COLOR CORRECTED EPS FILE

11 BLEED BACKGROUND ART 1/8”

12 COLOR / FONT: PART NUMBER - WHITE / HELVETICA REG. 6 PT.

13 COLOR / FONT: QUANTITY TEXT - BLACK W/ WHITE DROP SHADOW / FORMATA BOLD COND. 31 PT.;
 PACK TEXT - WHITE W/BLK DROP SHADOW CENTERED IN WHITE RECTANGLE / FORMATA BOLD COND. U&LC 22 PT.
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VOICE AND DATA



  

VIDEO

PMS

205



QuickPort

PMS

639

PMS

1235

MULTI-USE

PMS

259

STUCTURED

MEDIA



Hi-Speed 


COMPUTER

PMS

368

PMS

258

MUSIC



 


PHONE

PMS

1595

VIDEO

PHONE

CO
MPUTER

MUSIC

Each category has it’s own assigned color please follow the above chart.
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TVA COLOR CHART 

VIDEO; 
ANTENNA 
REMOTE 

PMS 
205 

PMS
285

PMS 
152 

PHONE 

PMS 
536 

TRAVEL 

PMS
521

6-WIRE
PHONE

PMS
319

TOOL

PMS 
3405 

AUDIO 

BASE TVA
COLOR

PMS
116

MULTI
MEDIA

 
 



ackaging

esign and

rocurement






PACKAGING DESIGN MANUAL
Packaging Design

47

 IMPORTANT: THIS IS A “GENERAL” POLYBAG TEMPLATE. ART & TEXT ATTRIBUTES MAY HAVE TO BE ADJUSTED
 DEPENDING ON THE SIZE OF THE BAG AND/OR PRODUCT. 

 1   COLOR: BACKGROUND - WHITE SPOT / PLATE DESIGNATED “WHITE SPOT” BECAUSE CMYK SEPARATION WILL NOT RECOGNIZE A PLATE NAMED “WHITE”; 

  MUST BE ANOTHER NAME, HENCE THE COLOR DESIGNATION “WHITE SPOT”. 

 2   COLOR: LEVITON BACW LOGO - PANTONE 2935 C HERE.

 3   COLOR: MEATBALL, HORIZONTAL BAND - PANTONE 2935 C. VERTICAL BAND COLOR IS DEPENDING ON CATEGORY 

  (i.e.: RESIDENTIAL - PANTONE 284 C / INDUSTRIAL - PANTONE 117 C / COMMERCIAL - PANTONE 187 C) 

 4   PLACE APPROPRIATE LOGO HERE. (IF NEEDED)

 5   COLOR / FONT: NUMBER TEXT - WHITE / HELVETICA BLACK 36PT.; DESCRIPTION TEXT - WHITE / HELVETICA CONDENSED 10PT. OVER 14PT.

 6   COLOR / FONT: VERTICAL BAR "CATEGORY" TRILINGUAL TEXT - FORMATA BOLD CONDENSED 18PT. (THIS TEXT CAN BE COMPRESSED TO FIT WHEN NECESSARY).

 7   PLACE APPROPRIATE LOGO(S) HERE. (IF NEEDED) 

 8   PLACE STANDARD BARCODE FOR CD AND CI (UPC (A).General.EPS) HERE WITH SAN-CAT-DASH ABOVE / HELV REG. 8PT. & MULTI-SOURCE SAN NEXT TO IT ON RIGHT / HELV. REG. 7PT. 

 9   COLOR / FONT: WARNINGS AND / OR BODY TEXT - PANTONE 2935 C / HELVETICA (SIZE TO FIT). 

10   COLOR / FONT: PRODUCT INFO BOX(ES) & IMPORT/EXPORT STATEMENT - PANTONE 2935 C / HELVETICA (SIZE TO FIT).

11   COLOR: LEVITON BACW LOGO - PANTONE 2935 C HERE.

12   PLACE RECYCLE SYMBOL HERE -  PANTONE 2935 C

13   COLOR / FONT: FILENAME AND PK# TEXT -  PANTONE 2935 C / HELVETICA REGULAR 7PT. & 6PT.

POLYBAG Template - For FILM OUTPUT

17 89

1011 12 13

6

2 43

3

5
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QTY/QTE/CANT

COLOR/COULEUR SAN

CAT

ALMOND
15A-125V

FEED-THROUGH 20A-125V701
6599-A

UL
LISTED





1

G

W

5-15R

GROUND FAULT 
CIRCUIT 
INTERRUPTER
RECEPTACLE 15A-125V
FEED-THROUGH
20A-125V

There needs to be a MINIMUM 1/8"
quiet zone on the right and left side of barcode.

OUTLET 

PRISE

CONTACTO  

QTY//QTE/CANT

10
SAN

5320-WCP

15A-125V 

CAT

COLOR/COULEUR

WHITE/BLANC/
BLANCO 212

G

W

5-15R

LISTED
RECEPTACLE

264B

UL®

1/8"1/8"

1/8"1/8"

3Setting Up Barcodes

Note: Barcode pro is not the best program and your settings can change from time to time. It is advised to
always check your specs for every generated barcode.
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1
3

1

LA Label Specs

ITF SCC-14 Open Frame

LA Label Specs

Code 128 Optimized General

Narrow Bar: 0.015748

MOST CRITICAL, NO DEVIATION!
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WALMART TB Label Specs

UPC-A General

WALMART TB Label Specs

ITF SCC-14 Open Frame
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CD and CI Label Specs

UPC-A General

TB Label Specs

ITF SCC-14 Open Frame
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LB Label Specs

ITF SCC-14 Open Frame

SB Label Specs

UPC-A General
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TA Label Specs

UPC-A General

EP Label Specs

UPC-A General

Minimum Bar Height .5
Anything under this measurement needs
to be approved by Gus or Scott.
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Acenti EP Label Specs
Mid Atlantic Custom Label:
2.907x1.375 / PK-92731-00-00-00
DEVICE BOX
UPC-A General

Acenti EP Label Specs
Mid Atlantic Custom Label:
2.907x2 / PK-92732-00-00-00
DIMMER BOX
UPC-A General
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Acenti EP Label Specs
Mid Atlantic Label:
1.875x3 / PK-92739-00-00-00
1,2,3 GANG
UPC-A General

Acenti EP Label Specs
Mid Atlantic Label:
4x2.5 / PK-92740-00-00-00
4,5,6 GANG
UPC-A General
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Customer Number

90
5 

(9
00

 E
X

T
)

Private Label
Multisource Specs

UPC-A General INTERNAL SAN
7 pt. Helvetica

EXTERNAL SAN
6 pt. Helvetica

TA Label Specs - 1.25 X .5

UPC-A General
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Code 39 General

 

(1) 6LP23

XXX-XXXXX-XXX

1 2 3

4

6

5

X
X

X

MOST CRITICAL,
make sure none of
these boxes are
checked

These specific numbers
are for example only.
The "Symbol Width" and
"W/N Ratio" numbers
may vary according to
the 100% magnification.

The magnification
must stay at 100%.

GRAINGER SPECS

TA Label Specs (Grainger)

Human Readable Quantity - Must be in parenthesis

A single space between quantity and Grainger No.

Human Readable Grainger No.

Code 39 Barcode - Must encode quantity + single space + Grainger No.
Note: DO NOT encode parenthesis

DO NOT encode suffix
EXAMPLES:

Grainger Code 39
Human Readable Barcode
(1) 5W217 1 5W217
(10) 5W217A 10 5W217 (Note that suffix "A" is ommitted)
(100) 6LP23 100 6LP23

San-Cat-Dash of Leviton assigned Finished Good No. - 7pt. Helvetica
Note: DO NOT use the dash No. of the TA no. assigned

Internal Control Number - 7pt. Helvetica
EXAMPLE: TA-511-ODS10-2A1 ÁJust use the last 3 digits

1

2

3

4

5

6
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Barcode Specs for FLEXO PRINTING on White Corrugated Medium
(NOT FOR PRINTING ON KRAFT) FIBRE VENDOR ONLY

115

UPC A BARCODE

CODE 128 BARCODE

ITF-14 OPEN BEARER BAR BARCODE

000-47000-MKB

00
0

Bearer Bar 9pt.

1/4 inch
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Barcode Specs for FLEXO PRINTING on KRAFT

The following are for ITF-14:
The maximum size is:
120% magnification
BWR: 0.005”
W/N ratio: 2.5
Bar height: 1.5”
X-dim: 0.048”
Narrow bar width: 0.043”
Bearer bar thickness: 0.19”
Printer DPI: 300

THE PREFERRED SIZE IS:
100% magnification
BWR: 0.005”
W/N ratio: 2.5
Bar height: 1.25”
X-dim: 0.04”
Narrow bar width: 0.035”
Bearer bar thickness: 0.19”
Printer DPI: 300

The minimum size is:
80% magnification
BWR: 0.005”
W/N ratio: 2.5
Bar height: 1”
X-dim: 0.032”
Narrow bar width: 0.027”
Bearer bar thickness: 0.19”
Printer DPI: 300

ITF SCC-14 OPEN FRAME BAR BARCODE

The Bar Code Pro
file needs to be
opened in
Illustrator to make
the bearer bar
completely
surround the bar
code.
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The following is for Code 128:
250% magnification
BWR: 0.005”
W/N ratio: 2.0
Bar height: 1”
X-dim: 0.025”
Narrow bar width: 0.02”
Printer DPI: 300

L00

CODE 128 OPTIMIZED GENERAL BARCODE

Barcode Specs for FLEXO PRINTING on KRAFT
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4Carton Labels
Note: These are standard carton labels. There are occassions when a new size will be
required. If not already on the server please create a new one and place on the server.
You can find the templates in a folder called Corp. Design - Templates. See (LABEL
TEMPLATES folder). Use the below specs as a guide. 

14

UL(no®), CSA, NOM/ANCE LOGOS
HERE WHEN INDICATED.

NEMA, IF THERE IS ROOM HERE

NEMA
LOGO

HERE WHEN
THERE IS NO 
ROOM ABOVE

6

712

3

LA Template 

QTY
QTE
CANT

EXT

INT RATINGINNER
INT

COLOR/COULEUR

3.
00

0"

4.875"

SAN-CAT-DASH

ENGLISH DESCRIPTION
FRENCH DESCRIPTION
SPANISH DESCRIPTION

XX
X XXX 15A-125VAC

L
0
0

1

13

9

11

4

5

2

XXXXX
XXXXXX

8 11

10

12

4

XXXXXXXXX

DIE LINE INCLUDING DIMENSIONS - PANTONE 185 C SPOT COLOR ( SWATCH NAMED DIE LINE) 

COLOR / SCALE: LEVITON BACW LOGO - BLACK / 31% 

COLOR / STYLE: UPC - BLACK / ITF 14 OPEN BEARER BAR. SEE LA LABEL SPEC SHEET

COLOR / FONT / SIZE: QTY & SAN-CAT-DASH TEXT - BLACK / HELVETICA BOLD 18PT. (100% HORIZONTAL SCALE)

COLOR / FONT / SIZE: INNER & INT TEXT - BLACK / HELVETICA BOLD / 14PT.

COLOR / FONT / SIZE: COLOR TEXT - BLACK / HELVETICA BOLD / 7 ON 8PT.

COLOR / FONT / SIZE: ITEM DESCRIPTION TEXT - BLACK / HELVETICA BOLD / 12 ON 11PT. 

COLOR / FONT / SIZE: FILENAME TEXT - BLACK / HELVETICA REGULAR / 6PT.

COLOR / STYLE: UPC - BLACK / CODE 128. SEE LA LABEL SPEC SHEET

COLOR / SCALE: UPC LOGO - BLACK / 75%

COLOR / SCALE: AGENCY LISTINGS AND OR NEMA - BLACK / SCALE TO FIT

COLOR / FONT / SIZE / STYLE: BLACK / HELVETICA BOLD / 14PT. / NOTE: IF VAC RATING ADD KERNING
OF 30 EMS BETWEEN V AND AC.

COLOR / FONT / SIZE: UPC TEXT- BLACK / OCR-B / 5 PT. SEE LA LABEL SPEC SHEET

COLOR / FONT / SIZE: COMPETITOR CAT. NUMBER - BLACK / HELVETICA BOLD / 12 ON 11PT. 

 

 1 

 2 

 3 

 4 

 5 

 6 

 7 

 8 

 9 

10

11

12

13

14

LA-XXX-XXXXX-XXX
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TB Template (Standard) 

XX
QTY/QTE/CANT

COLOR/COULEUR SAN

CAT

ENGLISH DESCRIPTION
FRENCH DESCRIPTION
SPANISH DESCRIPTION

T
B

-X
X

X
-X

X
X

X
X

-X
X

X
X

X
X

XXXXX/XXXXX XXX
CAT-DASH
RATINGS

3.500"

2.875"

UL(no®), CSA,
NOM/ANCE LOGOS

HERE WHEN
INDICATED.

NEMA, IF THERE
IS ROOM HERE

44

1

2
3

8

9

4

5

6

7

10

4

DIE LINE INCLUDING DIMENSIONS - PANTONE 185 C SPO T COLOR ( SWATCH NAMED DIE LINE) 

COLOR / FONT / SIZE: COLOR TEXT - BLACK / HELVETICA BOLD / 8.5PT. 

COLOR / FONT / SIZE: ITEM DESCRIPTION TEXT - BLACK / HELVETICA BOLD / 12 ON 14PT.

COLOR / FONT / SIZE: QTY & CAT-DASH TEXT - BLACK / HELVETICA BOLD 18PT. (100% HORIZONTAL SCALE)

COLOR / FONT / SIZE / STYLE: BLACK / HELVETICA BOLD / 12PT. / NOTE: IF VAC RATING ADD KERNING
OF 30 EMS BETWEEN V AND AC.

COLOR / SCALE: AGENCY LISTINGS AND OR NEMA - BLACK / SCALE TO FIT

COLOR / FONT / SIZE: FILENAME TEXT - BLACK / HELVETICA REGULAR / 6PT 

COLOR / SCALE: LEVITON BACW LOGO - BLACK / 23% 

COLOR / STYLE: UPC - BLACK / ITF 14 OPEN BEARER BAR (SEE LA LABEL SPEC SHEET)

COLOR / FONT / SIZE: COLOR TEXT - BLACK / HELVETICA REGULAR / 6PT

 1 

 2 

 3 

 4 

 5

 6

 7

 8

 9

10
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TB Template (Walmart Version) 

XX
QTY/QTE/CANT

COLOR/COULEUR SAN

CAT

ENGLISH DESCRIPTION
FRENCH DESCRIPTION
SPANISH DESCRIPTION

XXXXX/XXXXX XXX
CAT-DASH
RATINGS

3.500"

2.875"
UL(no®), CSA,

NOM/ANCE LOGOS HERE WHEN
INDICATED. NEMA, IF THERE

IS ROOM HERE

44

1

2
3

8

9

4

5

7

10

4

12

11

DIE LINE INCLUDING DIMENSIONS - PANTONE 185 C SPO T COLOR ( SWATCH NAMED DIE LINE) 

COLOR / FONT / SIZE: COLOR TEXT - BLACK / HELVETICA BOLD / 8.5PT. 

COLOR / FONT / SIZE: ITEM DESCRIPTION TEXT - BLACK / HELVETICA BOLD / 10 ON 12PT.

COLOR / FONT / SIZE: QTY & CAT-DASH TEXT - BLACK / HELVETICA BOLD 18PT. (100% HORIZONTAL SCALE)

COLOR / FONT / SIZE / STYLE: BLACK / HELVETICA BOLD / 12PT. / NOTE: IF VAC RATING ADD KERNING
OF 30 EMS BETWEEN V AND AC.

COLOR / SCALE: AGENCY LISTINGS AND OR NEMA - BLACK / SCALE TO FIT

COLOR / STYLE: UPC - BLACK / UPC (A) (SEE EP LABEL SPEC SHEET) 

COLOR / SCALE: LEVITON BACW LOGO - BLACK / 23% 

COLOR / STYLE: UPC - BLACK / ITF 14 OPEN BEARER BAR (SEE LA LABEL SPEC SHEET)

COLOR / FONT / SIZE: MULTI-SOURCE NO. - BLACK / HELVETICA REGULAR / 6PT

COLOR / FONT / SIZE: FILENAME TEXT - BLACK / HELVETICA REGULAR / 6PT

COLOR / FONT / SIZE: COUNTRY OF ORIGIN - BLACK / HELVETICA REGULAR / 9PT

 1 

 2 

 3 

 4 

 5

 6

 7

 8

 9

10

11

12

TB-XXX-XXXXX-XXX

X
X

X

FOR REFERENCE ONLY
NOT TO BE USED AT CHECKOUT

MADE IN CHINA

6
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DIE LINE INCLUDING DIMENSIONS - PANTONE 185 C SPO T COLOR ( SWATCH NAMED DIE LINE) 

COLOR / FONT / SIZE: SAN-CAT - BLACK / HELVETICA REGULAR / 5.5PT  

COLOR / STYLE: UPC - BLACK / UPC (A) (SEE TA LABEL SPEC SHEET, THIS VARIES ACCORDING TO LABEL SIZE)
Must have approval from PDP Director/Manager for any Bar Code that is below 80% Magnification, see TA Bar Code Specs

COLOR / FONT / SIZE: MULTI-SOURCE NUMBER - BLACK / HELVETICA REGULAR / 4.5PT

 1 

 2 

 3

 4

TA Template (Varies according to box size) 

TA Product UPC Label

1.250"
0.500"

R41-699

R
41

1
2

4

3

1.875"

0.938"

003-AEH50-WH

00
3

1

3

4

2
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PK-92775-20-00-00 OR EQUIVALENT - PANTONE 185 C SPOT COLOR (SWATCH NAMED DIE LINE)

COLOR / STYLE: HOME DEPOT 6 DIGIT SKU NUMBER - BLACK / HELVETICA BOLD / 72PT  

COLOR / FONT / SIZE: EXTERNAL SAN-CAT-DASH - BLACK / HELVETICA REGULAR / 6PT

COLOR / FONT / SIZE: FILENAME - BLACK / HELVETICA REGULAR / 5PT

 1 

 2 

 3

 4

3.938" 

1.406" 342862 
XXX-XXXXX-XXX T

A
-X

X
X

-X
X

X
X

X
-X

X
A1 

3 

4

2 

TA Template for Home Depot  (Pending name change)
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QTY/QTE/CANT CAT

COLOR/COULEUR SAN

2.6"

1.3"
ENGLISH DESCRIPTION
FRENCH DESCRIPTION
SPANISH DESCRIPTION 

EP-XXX-XXXXX-XXX

X
X

X

XXX RATINGS

CAT-DASHXX

XXXX/XXXXXX/XXXXX

DIE LINE INCLUDING DIMENSIONS - PANTONE 185 C SPO T COLOR ( SWATCH NAMED DIE LINE) 

COLOR / FONT / SIZE: COLOR TEXT - BLACK / HELVETICA BOLD / 6PT. 

COLOR / FONT / SIZE: ITEM DESCRIPTION TEXT - BLACK / HELVETICA BOLD / 6.5 ON 7.8PT.

COLOR / FONT / SIZE: QTY & CAT-DASH TEXT - BLACK / HELVETICA BOLD 9PT. (100% HORIZONTAL SCALE)

COLOR / FONT / SIZE / STYLE: RATINGS - BLACK / HELVETICA BOLD / 9PT. / NOTE: IF VAC RATING ADD KERNING
OF 30 EMS BETWEEN V AND AC.

COLOR / SCALE: AGENCY LISTINGS AND OR NEMA - BLACK / SCALE TO FIT

COLOR / FONT / SIZE: FILENAME TEXT - BLACK / HELVETICA REGULAR / 5PT  

COLOR / STYLE: UPC - BLACK / UPC (A) (SEE EP LABEL SPEC SHEET)

COLOR / FONT / SIZE: COLOR TEXT - BLACK / HELVETICA REGULAR / 5PT

COLOR / SIZE: HOLDING LINE - BLACK / 1.5P T.

 1 

 2 

 3 

 4 

 5

 6

 7

 8

 9

10

1

2

3 9

10

5

6

7 8

UL(no®), CSA,
NOM/ANCE LOGOS

HERE WHEN INDICATED.

4 4

EP Template (Varies according to box size) 
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3.
00

0"

4.875"

PK-06881

CARTONS PER TIER     = 16
TIERS PER PALLET     = 18
CARTONS PER PALLET  = 288

LX-XXX-XXXXX-XX

DIE LINE INCLUDING DIMENSIONS - PANTONE 185 C SPOT COLOR ( SWA TCH NAMED DIE LINE)

INFORMATION PROVIDED BY ERNESTO

PALLETIZATION DIAGRAM PROVIDED BY ERNESTO

INFORMATION PROVIDED BY ERNESTO 

COLOR / FONT / SIZE: FILENAME - BLACK / HELVETICA REGULAR / 6PT

 1 

 2 

 3

 4

 5

5
4

2

1

3

LX Label Template
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3.875" 

1.875" 

U0144

U0144

10

PACK QUANTITY

LX-XXX-XXXXX-XXX-XX

1

2

3

4

5

DIE LINE INCLUDING DIMENSIONS - PANTONE 185 C SPO T COLOR ( SWATCH NAMED DIE LINE) 

COLOR / FONT / SIZE: ACUITY PART NUMBER - BLACK / HELVETICA BOLD / 10PT

COLOR / STYLE: ACUITY PART NUMBER - BLACK / REFER TO SPECS PROVIDED FOR CODE 39 BARCODE

COLOR / FONT / SIZE: STANDARD PACK QUANTITY NUMBER - BLACK / HELVETICA BOLD / 10PT

COLOR / STYLE: ACUITY PART NUMBER - BLACK / REFER TO SPECS PROVIDED FOR CODE 39 BARCODE

COLOR : BLACK 1P T. RULE

COLOR / FONT / SIZE: FILENAME TEXT - BLACK / HELVETICA REGULAR / 6PT

 1 

 2 

 3 

 4 

 5

 6

 7

6 7

ACUITY LABEL SPECS - CODE 39

Acuity Label Template
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Production 5PDP Artwork SpecificationsPDP Artwork Specifications
File requirements:
1. Fonts: All fonts used should be collected with the file (preferably as type 1 – screen and printer font). Avoid stylized fonts 

from within applications, true type or variable size fonts. 

2. Supply all supporting/linked files. When supplying a flattened image file it is recommended that the layered Photoshop file be supplied as well
in case manipulation is required in the future. It is preferred to have images linked rather than embedded.

3. Software/format supported: Mac is the platform. The majority of files supplied have been created using Illustrator, Photoshop, Quark, 
Pagemaker and Indesign. Other platforms, software and formats need to be addressed on a case by case basis.

Design elements:
1. Design using Pantone and CMYK color space. 

2. Graphic designs should be created to fit at full scale. Follow the orientation for front/top of graphics as identified on the structure. The Die 
should be on a separate layer and output as a separate spot color. The PK number (Die Line ID number) and print side should also be identified.

3. Build the file(s) in the colors desired and delete all unused swatches. For images requiring spot colors build as a DCS file. [(For PMS colors 
use the standard ink name from Pantone Library) (Example 2935 C)]. Note: Grayscale tifs colorized in Quark are acceptable but are not 
preferred by most production vendors. 

4. Check consistency (CMYK breakdowns) of colors used between applications (CMYK values/colors created in Illustrator match those created 
in Quark, Photoshop, or Indesign). Colors should have the same name in all applications. Are some colors PANTONE 2935 C while others 
are PANTONE 2935 CVC?

5. 4 color process or Spot images should be supplied at 300 DPI. Effective resolution should be no less then 300. Calculate by dividing the files 
resolution by the scale that the image is placed (300 DPI @ 100% = 300 / 1 = 300 Resolution; 300 DPI @ 50% = 300 / .5 = 600 Resolution). 

If these resolutions are not achievable or the design doesn’t require (blurred pattern) please assure that the lower resolution supplied is 
acceptable quality. Note: logos and text supplied as part of an image has degraded quality when compared with those supplied as vector graphics.

6. UPC-A bar codes should be created at 100% scale with a .001” bar width reduction.

7. Graphics and/or Illustrations should be extended past the die outline by 1/8” for bleed requirements.
a. For carton work, bleeds should extend 1/8” into dust flaps, glue flaps and beyond cut/trim. Do not exceed over glue areas.
b. Tuck panels will bleed 1/8” into dust flaps (miter corners @ 45? with main panel bleed)
c. Dust flaps if printed should bleed 1/8” beyond cut.
d. Text is recommended to be no closer than 1/16” (preferably 1/8”) from all cuts and creases.
e. If graphics are intended to wrap-around and align with graphics on other panels, position, alignment and square should be verified by 

measuring the elements in the file and/or creating a comp.

8. Avoid using transparency features and effects. Using these features will require additional desktop time and is very difficult to duplicate in production.

9. It is mandatory that spell check be performed on the file before submitting.

10.Do not trap files. It is the responsibility of the production vendor.

FTP/Email:
A PDF of the final graphic should be included with the native files. This will be used in comparison to the final workup for quality control 
purposes and as quick view of work files on the server.

Production:
1. A color composite printout with a review of black & white separation prints (SEPS) is mandatory before each file submission. The color 

composite is used in comparison to the final workup for quality control purposes. The black and white prints enable the designer and all 
others involved to verify how many colors are in the file and confirm that the elements are built using the appropriate color(s). 

2. Any special requirements or file modifications should be communicated in writing and/or on the composite prints supplied.

3. It is required that all files be flightchecked (See flightcheck tutorial).

Specialty:
Embossing plates, foil stamping, spot varnish and coating omits should be identified clearly for exact position to art/structure. These can be 
communicated within the file as a separate spot color or a dash pattern within Illustrator.
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Production PDF TutorialProduction PDF Tutorial

How To Set-Up a script for a Production PDF in Quark XPress

Before creating a PDF check that the status of your picture usage and fonts are all in OK status. To to this go
to Quark XPress Menu Utilities > Usage. Also review your artwork and check that all your colors in the
document are CMYK or PMS spot colors as stated on your file spec box. Make sure that you are not using
RGB colors. There are three things that you must be aware before creating a production PDF and they listed
below as steps A thru C.

A. Size – A production PDF MUST be created at 100%. Also make sure that the size of your file fits on the
Paper Size selected, otherwise a Custom Size has to be created.

B. Colors – To create a production PDF to be output as a composite layout as well as in separations for offset
printing, QuarkXPress 6 has DeviceN capabilities that let you create a file with composite PostScript, To
specify DeviceN: Use step 4 and choose Print Colors > DeviceN.
Use DeviceN to output blends, multi-inks, colorized TIFFs, and other items as composite, while retaining
their color separation definitions.

Note: If you specify DeviceN and then produce a PDF (or print) a project that contains DCS files, a
message will display to alert you that separations will be restricted for those files. To create a
Production PDF from a file that contains DCS files, a Color Separated Production PDF has to
be created in order to retain the DCS effect. Then PDF must be output following the procedure
“How to How To Produce Film from a Production Adobe PDF Document Using Adobe Illustrator
CS” 

C. Fonts – When creating a PDF by printing using Adobe PDF Printer, you are simulating a printing stage and
this way you will ensure that all the FONTS (resident in document and embedded in supporting graphics)
are force embedded in the PDF. So if steps 1 thru 7 are followed, you will assure that a PDF with all fonts

Related Topics 

If Adobe PDF Printer doesn't appear in the Printer
List dialog box
(Acrobat 6.0 on Mac OS X v10.3.x)
Solutions 
Do one of the following:
Solution  1: Update to Acrobat 6.0.1. 
To update to Acrobat 6.0.1:
1. Start Acrobat 6.0.
2. Choose Help > Update.
3. Follow the on-screen instructions to install the

update.
Note:  You can also download the update from
the Adobe Web site at
www.adobe.com/support/downloads/main.html.

Solution 2: Add the Adobe PDF Printer manually. 
To add the Adobe PDF Printer to the Printer List dialog box:
1. Start the Printer Setup Utility in the Applications/Utilities folder.
2. Hold down the Option key, and click Add in the Printer List

dialog box.
3. Choose Advanced from the Printer Connection menu.
4. Choose Adobe PDF (pdf) from the Device menu.
5. Type  Adobe PDF  in the Device Name text box.
6. Type  pdf://www.adobe.com  in the Device URL text box.
7. Choose Adobe from the Printer Model menu.
8. Click OK.

Background information 
The script that Acrobat uses to install the Adobe PDF Printer
doesn't work in Mac OS X v10.3.x. The Acrobat 6.0.1 update
resolves this issue.
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How To Create an Adobe PDF file from Quark XPress using the Print command
(Mac OS):

1. Open the file that you want to convert to an Adobe PDF file and choose File > Print.

2. Choose Layout > Registration > Center > 6pt
If creating a color separated PDF check box for
Separations.

3. Choose Setup from the print dialog box and
choose the following settings: Adobe PDF for
Printer Description, Paper Size needed, Reduce
or Enlarge 100%, Center Page Positioning and
the Orientation needed.

4. Choose Output from the print dialog box and
choose the following settings:
Print Colors > DeviceN,
Halftoning  > Conventional,
Resolution > 3600, Frequency > 200, 

5. Choose Bleed from the print dialog box and
choose the following settings:
Bleed Type > Page Items,
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7. Click on printer, a warning window will pop up, click OK. A new window will pop up. Choose
Adobe PDF 7.0 under Printer and click Print. A window will pop up prompting you to save the file. Input the
name of and click OK. A new window will pop up. Click Print. The document will simulate printing, then a
PDF will be produced and it will appear on your desktop.

6. Choose Page Setup from the print dialog box. From the Page Setup choose Adobe PDF from the "Format
for:" and choose the Paper Size needed. Press OK.
Note: If the size of the document is different from the preset sizes, a custom size must be created.
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To eliminate steps in the creation of a Production PDF a SCRIPT has been developed. This Script
creates a postscript file on your desktop and uses Adobe Distiller to create the PDF. The following
settings must be set in Distiller in order to use this script.

SCRIPT to create Production PDF files from Quark XPress

1. Activate Adobe Distiller program and choose
Press Quality under Default Settings.

2. Go to Distiller Menu and select Settings >
Edit Adobe PDF Settings. General tab is
selected and choose Individually under
Auto-Rotate Pages. Optimize for Fast Web
View MUST NOT be checked on.

3. Go to Distiller Menu and select Settings >
Edit Adobe PDF Settings Click on Fonts
tab and input 99% as shown below.

4. Click OK and then save as Press Quality 1.
Make sure that the “Default Settings” is
selected to Press Quality 1 when creating
Production PDFs
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5. Go to Distiller Menu and select Settings >
Watched Folders Click Add Folder...

6. Select your Desktop to place these watched
folders. Under Postscript File is: Select Deleted
and click OK

7. Two folders are created on your Desktop with
the names In and Out

8. The previous 7 steps are the settings for your
Distiller. Now you need to install your script file. In
the folder “Production PDF tutorial” located on the
“GRAPHICS SERVER” there are 2 files:
“Script.xnt”  and “1 PDF SCRIPT” Place
Script.xnt in the XTension folder residing on
your Quark Application folder.
Place 1 PDF SCRIPT in the Scripts folder
residing on your Quark Application folder. Then
double click on this script file. A Script Editor
program will start and it will open a file that looks
like the window below. Edit the following
parameters:
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Mac OS = name of your hard drive where your system resides
GZH = name of the folder that has the house icon on your hard drive > Users
Acrobat Distiller 7.0 = name of Acrobat Distiller software that you are

going to use to create your PDFs and it resides
on your applications folder

After these changes are made go to Script Editor Menu File> Save.
Your script is ready to be used.
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12. Open the Quark file that you need to convert to a PDF. Important: Before running this Script, check that
the status of your picture usage and fonts are all in OK status. To do this go to Quark XPress Menu
Utilities > Usage. Also review your artwork and check that all your colors in the document are CMYK or
PMS spot colors as stated on your file spec box. Make sure that you are not using RGB colors. Go to
Quark Menu and select the script icon (see circled icon below), scroll down and select “1 PDF SCRIPT”
(first file on the list). A Print Window will pop up.

9. Activate Quark program and go to
Menu Edit > Print Styles and
create a New Print Style and name
it “Make PDF”.

10. Click on Setup tab and select:
Printer Description: Adobe PDF 7.0 or any Adobe
PDF version that is present. If an Adobe PDF
Printer doesn't appear in the Printer List dialog box
refer to page 1: Related Topics to install one.

11. Click on Output tab and select: 
Print Colors: DeviceN
Resolution: 3600
Frequency: 200
Click OK and click Save to save your new
PDF Print Style.

How to create a Production PDF in Quark XPress
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13. Select: Print Style: Make PDF Then click
Capture Settings. A window will pop up
simulating printing, then a PDF will be    produced
and it will appear on the Out folder on your
desktop. This PDF file will be a Composite PDF
file. This PDF must be output following the
procedure “How To Produce Film from a
Production Adobe PDF Document UsingAdobe
Illustrator CS”.

A brief description of what the Script does is as follows:

1. It takes the Quark document and copies the name of the document to the name of the layout.

2. Reads the size of the page of the document; creates a custom size increasing 1 inch to the document
so that crop and register marks are included; prints 100% and fits in the new custom size.

3. Changes some of the parameters needed to produce a press quality PDF.

4. Creates a postscript file and saves it to the In folder on your desktop.

4. Activates Acrobat Distiller to distill the postscript file created.

14. To create a Production PDF from a file that
contains DCS files, a Color Separated

Production PDF has to be created in order to
retain the DCS effect. To create Color Separated

Production PDF follow step 13. and in addition
to the settings on step 13. Check in Separations.
A window will pop up simulating printing, then a
PDF will be produced and it will appear on the
Out folder your desktop. This PDF file will be a
Color Separated PDF file. This PDF must be
output following the procedure “How To Produce
Film from a Production Adobe PDF Document
Using Adobe Illustrator CS”.
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1. Toolbar called Flagged items select Used spot color. Notice the multiple pantone colors. There should only be 3. PMS 2935, 284, & DIE LINE. Click on the icon next to the color. It 
will give you all the files that have that color. What you want to do is delete all colors that have the CVC indicated. Go into the native files and rename the color i.e. PANTONE 2935 C.
Make sure the CMYK break down is the same. For PANTONE 2935 all files should have a break down of Cyan 100, Magenta 47, Yellow 0, Black 0. It could be any break down just 
as long as all of the files have are the same. Once you have completed this you are done with color check. 

2. Check that all styles are PLAIN. It should not say BOLD. If it does go into your Quark/Indesign file & change the fonts that have a style of bold to a BOLD font. Example Helv style 
BOLD should be HelvBol. Never machine bold a font. This document is OK.

3. Make sure all your imported images are linked. Here you have 2 files that are missing. Go into Quark/Indesign and select usage update & link.

4. Make sure all your color modes are correct. If you see RGB you know you have a file that is not set up correctly. Example if you have a 2 color file you should only see 2 colors.

5. DPI on photos should be set to 300 in photoshop.

6. All photos should have a scaled range of 80% - 120%. This a recommended range. 100% is the best.

7. Pages and Page set up you can ignore. 

8. Notice RGB colors are in this document. You must delete them and any other unused colors from this Quark document.

9. Overview of Pantone colors shows that some illustrator files have unused colors. You must delete them in every illustrator file.

10.Indicates DIE LINE is set to overprint. You want that so the file separates correctly. See Separations beginning on page 3.

Flightcheck TutorialFlightcheck Tutorial

1

2

4

3

5 6

7

8

9

10
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11. After deleting all unwanted colors and matching all files with the same CMYK break down. The colors are now correct and ready for collecting.

12. Fonts are correct no modification was necessary. File is ready for collecting.

13. All files have been updated and properly linked.

14. Noticed flightcheck is saying that there is a mismatched color and PANTONE 284 C is highlighted in red. Unfortunately this is not accurate. I looked and they are correct. Its 
important that your Separations are correct. Flightcheck tends to flag everything. If you follow the important guidelines I have highlighted you will be ok. See SEPARATIONS on page 3.
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15.This section represents each plate.
This is the CYAN plate.

16.Look at every plate to assure they 
are separating correctly.

15

16

SB-MP0-09875-20A   7/30/01    3:41 PM    Page 1      (Cyan plate)
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17.All parts of the DIE LINE are represented. If they were 
not you would know that parts of it were not set to over
print. Be sure that die line is always set to overprint.

17SB-MP0-09875-20A   7/30/01    3:41 PM    Page 1      (Magenta plate)
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SB-MP0-09875-20A   7/30/01    3:41 PM    Page 1      (Black plate)
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SB-MP0-09875-20A   7/30/01    3:41 PM    Page 1      (Die Line plate)
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18.Everything in Black is representing 
PANTONE 284 C. Everything is correct.

18SB-MP0-09875-20A   7/30/01    3:41 PM    Page 1      (PANTONE 284 C plate)
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19. Everything that is black is represented as PANTONE 2935 C. Everything that 
is white is a knock out representing PANTONE 284 C or the color WHITE. The 
2935 plate is correct. If you saw parts of the DIE LINE you would know that the
die line file was not set to overprint.

19SB-MP0-09875-20A   7/30/01    3:41 PM    Page 1      (PANTONE 2935 C plate)
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20. Instructions on the inside of the box are all black. This is correct.

20
SB-MP0-09875-20A   7/30/01    3:41 PM    Page 2      (Black plate)
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21.This is the Die Line for the inside of box. Everything is ok.
21SB-MP0-09875-20A   7/30/01    3:41 PM    Page 2      (Die Line plate)
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COLORS:

� All colors should have same CMYK color break down. 

� All colors must be named the same. 

� All colors not used in file should be deleted. 

FONTS:

� No stylized, bolded or outlined fonts using font attributes should be present. 
The style of the font must always be Plain. For example: Printer font filename - Helvetica 
Bold Italic - Style: Plain 

IMAGES:

� Status - must be set to OK. 

� Mode - All files must be set up in either grayscale, CMYK or Duotone. 

� DPI - Resolution should be no less then 300 dpi unless flexo print is indicated then 
150 dpi is acceptable. 

� X and Y axis - should be equal. For example: X 80% Y 80%, unless it is a background 
with no art on it. 

� X and Y axis - Photo images should be set to 100% whenever possible. 80%-120% is
acceptable.

Flightcheck ChecklistFlightcheck Checklist
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After you have properly installed CADtools and launched Adobe Illustrator, you will notice new
CADtools drawing and dimensioning tools in the toolbox of Adobe Illustrator. In addition to the six new
tools you see in the toolbox, there are many popout tools. Select the small arrows on the right of the
tool icons and drag to highlight other tools. The six different tool groups can be separated by dragging
the tearoff icon at the end of each set of hidden tools.

Color icons and tool behavior
CADtools icons are distinguished by their red point markings. The red points indicate the position of
mouse-click(s) in relationship to the artwork created. Tool icons which have only one red point require
only one mouse-click-and-drag – except for the object center tool, which requires only one mouse-click
on a circle. Tool icons which have two red points require two mouse-clicks positioned on artwork as
shown in the icon. For most of these tools, you must drag the mouse after the second click.

Hot Tip!
The CADtools icons all contain red points which indicate the number and placement of
mouse-clicks required to properly use the tool.

1. Horizontal Dimension (by Line) - Click and drag out any
horizontal segment to dimension the horizontal
distance between two anchor points.

2. Horizontal Dimension (by Points) - Click multiple points
anywhere on the document and drag to dimension
their horizontal distances.

3. Horizontal Datum Dimension - Click a point of origin,
then click multiple points and drag to dimension the
horizontal distances from the origin.

4. Vertical Dimension (by Line) - Click and drag any
vertical segment to dimension the vertical distance
between two anchor points.

5. Vertical Dimension (by Points) - Click multiple points
anywhere on the document and drag to dimension
their vertical distances.

6. Vertical Datum Dimension - Click a point of origin, then
click multiple points and drag to dimension their
vertical distances from the origin.

7. Inclined Dimension (by Line) - Click and drag any
inclined segment to dimension the inclined distance
between two anchor points.

8. Inclined Dimension (by Points) - Click multiple points
anywhere on the document and drag to dimension
their inclined distances.

9. Inclined Datum Dimension - Click a point of origin, then
click multiple points and drag to dimension their
inclined distances from the origin.

10. Angle Dimension - Click a line of origin, then click and
drag a nonparallel line to dimension the angle between
the lines.

2D Dimensioning tools: from left to right

11. Arc Length Dimension - Click a point of origin on an
arc, then click and drag another point on the same arc
to dimension the length along the arc between the
points.

12. Diameter Dimension - Click and drag a point on a circle
to dimension its diameter.

13. Radius Dimension - Click and drag a point on a circle
to dimension its radius.

14. Bézier Curvature Dimension - Click and drag directly
over a curved line to display the radius of the curve at
the cursor location.

15. Tangent Dimension - Click and drag directly over a
curved line to display the tangent of the curve at the
cursor location. Use alt/option key to display the
tangent normal. Use shift to display the normal and
tangent lines. Use control to toggle normal placement.

16. Center line - Click and drag to create the line.

17. Object center - Click on an object line to mark the
center of its bounding box.

CADtools TUTORIAL

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17
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Hot Tip!

Dimensioning Objects

When dimensioning by points, be sure to use the precision cursor over the anchor
points to properly dimension the object. Inaccurate measurements will result if the
dimensions are pulled from the lines rather than the anchor points.

Quick Reference: Cursor feedback

While you are drawing and dimensioning with CADtools, you will receive additional
precision cursor feedback to help you select lines and anchor points in the correct order.

Precision cursor

Precision cursor
over path

Precision cursor
over anchor point

Precision cursor
waiting for second click

Cursor dragging
to create artwork

Cursor over
dimension line

Dimension Resize

The Dimension Resize tool allows you to change the distance between a dimension and
the object it measures while maintaining the link.

Note: Dimension changes made with any other tool will not be retained when

dimensions are updated with the Update links button.

Select the Dimension Resize tool and position the cursor over the label or dimension
line which you plan to resize. When the (     ) cursor appears, click and drag to adjust
the dimension. Use the shift key while dragging to place dimension lines at a consistent
distance from the object. This offset distance is defined in the Snap text box in the
Dimension lines panel of the CADstyle palette. To unlink a dimension from the object it
measures, select and ungroup the dimension.

.

.

.

.

.

+

Cursor description Activity status

CADtools drawing, editing, dimensioning or
labeling tool is selected

Tool is selected and cursor is directly over a path

Tool is selected and cursor is directly over an anchor point

Tool is selected, you have already clicked once, and you
need to click or click-drag to create artwork

Tool is selected, you have clicked once or twice,
and you are dragging

You are directly over a dimension line. You will not be able
to create a dimension when this cursor appears.
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Example: How to Dimension a Dieline Using CADtools

We recognized the outer rectangle to be a round corner rectangle. To dimension the horizontal line
(width) we use the Horizontal Dimension (by Points) tool. Then, Click on the point 1, Click on the
point 2, Hold and Drag in an upward direction to get the dimension from point 1 to point 2. 

To dimension the Vertical line (height) we use the Vertical Dimension (by
Points) tool. Then, Click on the point 3, Click on the point 4, Hold and Drag
to the right to get the dimension from point 3 to point 4. 

Click
anchor
point 1

Click
anchor
point 2HOLD

AND
DRAG

Click
anchor
point 3

Click
anchor
point 4

HOLD
AND

DRAG

3.000"

3.000"

2.500"
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We recognized the inner rectangle to be a straight rectangle. To dimension the horizontal line (width)
we use the Horizontal Dimension (by Line) tool. Then, Click on line 1, Hold and Drag in an upward
direction to get the horizontal dimension of the rectangle (width).

Click line 1

HOLD
AND

DRAG

3.000"

2.500"
1.000"

To dimension the Vertical line (height) we use the Vertical Dimension (by Line) tool.
Then, Click on line 2, Hold and Drag to the right to get the vertical dimension of the
rectangle (height).

Click line 2

HOLD
AND

DRAG

3.000"

2.500"
1.000"

0.500"



ackaging

esign and

rocurement






PACKAGING DESIGN MANUAL
Production

93

To dimension the Radius of the round corner of the outer rectangle use
the Bézier Curvature Dimension tool. Then Click on the arc 1, Hold and
Drag toward the center of the rectangle
and you'll get the radial dimension
of the round corner.Click

arc 1

HOLD
AND

DRAG

3.000"

2.500"
1.000"

0.500"

R 0.250"

Example: How to Draw an Isometric Cube

To draw an Isometric Cube we select the Isometric Cube tool.
Click on the Illustrator page and a window A appears. Enter
the W L D dimensions and Click OK.

window A
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Example: How to Dimension an Isometric Cube

To dimension the height of an Isometric Cube we select the Vertical
Isometric Dimension (by Line) tool. Click on the vertical line H and
get the dimension of the height of the cube.

2.000"

To dimension the width and the depth an Isometric Cube, we select the
Horizontal Isometric Dimension (by Line) tool. Click on W and D horizontal
lines to get the width and depth dimensions of the cube.

2.000"

4.000"
3.000"

H

W
D

H

W
D

Click
line H

Click
line W

Click
line D

HOLD
AND

DRAG

HOLD
AND

DRAG
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Processing Artwork
All artwork must be approved by at least a peer and the plant. When applicable approvals from other groups
such as product management, marketing, QA, etc. will be indicated by PDP director or manager. The elements in
packaging that are critical enough to render artwork unusable if they are not completed & checked are the following:

Check Digital File Color Separations

Check Die Line (Set to overprint) / Spec Box

UPC Code

Country of Origin / Import, Export Statement

Ratings

Agency Listings

Cat.No. in Front / SAN-CAT-DASH above UPC/ No zeros before CAT / DASH

Product Description

Correct Filename / Correct Part Number / PK Number / MS Number

Comp. if New (i.e. Displays, Clamshells, Boxes, etc.)

Instruction Sheet Fold Scheme and fit into packaging

CHECKED BY: DATE:

Flexo Printing - Barcode is to Spec

Julian date added to artwork when applicable

Recycle Symbol added to artwork

LX OVERSEAS PALLETIZATION CAN NOT exceed Height of 44.5

Provide PDF with separations when applicable

Transferred compressed files to Leviton FTP site

Create postscript PDF with embeded fonts

Remove “X” suffix designation from file name and part number

ARTWORK CHECKLISTARTWORK CHECKLIST

6
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Check that all Plates are Included

FILM CHECKLISTFILM CHECKLIST

Check all Copy/Artwork is Stepped Correctly on Each Plate

Check Proper ID of Each Plate and ADD if Missing

Check Trapping!

Tape All Plates Together for Each Individual Item

Tape Die Line Overlay Over Matchprint OR

Artist Signature: Date:

If No Matchprint - Provide Extra Printed Copy & Pantone Swatch 

Add Files to Server (See server tutorial for proper filing.)

Art.  /  NA

All film must be reviewed to make sure the plates are separating and the trapping is correct. Blue prints and
or matchprints must be photocopied for job folder.
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END 

 If changes required, verify or confirm  
to proceed with changes  

with Management 

Update art if required. 

Update all folder information and 
release to Iris and Purchasing 

for processing 

Send reminder to 
approval group. New 

lead time - 24 hrs. 

Have all 
responses 

been received 

S T A R T 

Artwork complete 
and ready for review 

48 hour approval lead-time  
for initial review. 

PDP internal review 

Route artwork per 
predefined approval 

group and only to this 
approval group 

Create Outlook e-mail and send 
PDF of artwork to  

approval group 

Review 
O.K. 

2 

2 

NO 

NO 

YES 

PD P  ARTWORK APPRO V A L 

1 

YES Must request that all approvers  
re-approve updated art 

Do changes 
require a 2nd  

round of approval 
(ie extensive  

changes) 

1 

 

YES 

NO 
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When artwork requires a Julian Date, please refer to the Julian Date Calendars on pages 98 and 99 for the
correct number. Refer to Standard Operating Procedure "LNPDPA-P295 Revising Released Packaging Art
Using Julian Date" when issuing a Julian date.

Day Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec Day
1 001 032 060 091 121 152 182 213 244 274 305 335 1
2 002 033 061 092 122 153 183 214 245 275 306 336 2
3 003 034 062 093 123 154 184 215 246 276 307 337 3
4 004 035 063 094 124 155 185 216 247 277 308 338 4
5 005 036 064 095 125 156 186 217 248 278 309 339 5
6 006 037 065 096 126 157 187 218 249 279 310 340 6
7 007 038 066 097 127 158 188 219 250 280 311 341 7
8 008 039 067 098 128 159 189 220 251 281 312 342 8
9 009 040 068 099 129 160 190 221 252 282 313 343 9

10 010 041 069 100 130 161 191 222 253 283 314 344 10
11 011 042 070 101 131 162 192 223 254 284 315 345 11
12 012 043 071 102 132 163 193 224 255 285 316 346 12
13 013 044 072 103 133 164 194 225 256 286 317 347 13
14 014 045 073 104 134 165 195 226 257 287 318 348 14
15 015 046 074 105 135 166 196 227 258 288 319 349 15
16 016 047 075 106 136 167 197 228 259 289 320 350 16
17 017 048 076 107 137 168 198 229 260 290 321 351 17
18 018 049 077 108 138 169 199 230 261 291 322 352 18
19 019 050 078 109 139 170 200 231 262 292 323 353 19
20 020 051 079 110 140 171 201 232 263 293 324 354 20
21 021 052 080 111 141 172 202 233 264 294 325 355 21
22 022 053 081 112 142 173 203 234 265 295 326 356 22
23 023 054 082 113 143 174 204 235 266 296 327 357 23
24 024 055 083 114 144 175 205 236 267 297 328 358 24
25 025 056 084 115 145 176 206 237 268 298 329 359 25
26 026 057 085 116 146 177 207 238 269 299 330 360 26
27 027 058 086 117 147 178 208 239 270 300 331 361 27
28 028 059 087 118 148 179 209 240 271 301 332 362 28
29 029 088 119 149 180 210 241 272 302 333 363 29
30 030 089 120 150 181 211 242 273 303 334 364 30
31 031 090 151 212 243 304 365 31

PERPETUAL
JULIAN DATE CALENDAR
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Day Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec Day
1 001 032 061 092 122 153 183 214 245 275 306 336 1
2 002 033 062 093 123 154 184 215 246 276 307 337 2
3 003 034 063 094 124 155 185 216 247 277 308 338 3
4 004 035 064 095 125 156 186 217 248 278 309 339 4
5 005 036 065 096 126 157 187 218 249 279 310 340 5
6 006 037 066 097 127 158 188 219 250 280 311 341 6
7 007 038 067 098 128 159 189 220 251 281 312 342 7
8 008 039 068 099 129 160 190 221 252 282 313 343 8
9 009 040 069 100 130 161 191 222 253 283 314 344 9

10 010 041 070 101 131 162 192 223 254 284 315 345 10
11 011 042 071 102 132 163 193 224 255 285 316 346 11
12 012 043 072 103 133 164 194 225 256 286 317 347 12
13 013 044 073 104 134 165 195 226 257 287 318 348 13
14 014 045 074 105 135 166 196 227 258 288 319 349 14
15 015 046 075 106 136 167 197 228 259 289 320 350 15
16 016 047 076 107 137 168 198 229 260 290 321 351 16
17 017 048 077 108 138 169 199 230 261 291 322 352 17
18 018 049 078 109 139 170 200 231 262 292 323 353 18
19 019 050 079 110 140 171 201 232 263 293 324 354 19
20 020 051 080 111 141 172 202 233 264 294 325 355 20
21 021 052 081 112 142 173 203 234 265 295 326 356 21
22 022 053 082 113 143 174 204 235 266 296 327 357 22
23 023 054 083 114 144 175 205 236 267 297 328 358 23
24 024 055 084 115 145 176 206 237 268 298 329 359 24
25 025 056 085 116 146 177 207 238 269 299 330 360 25
26 026 057 086 117 147 178 208 239 270 300 331 361 26
27 027 058 087 118 148 179 209 240 271 301 332 362 27
28 028 059 088 119 149 180 210 241 272 302 333 363 28
29 029 060 089 120 150 181 211 242 273 303 334 364 29
30 030 090 121 151 182 212 243 274 304 335 365 30
31 031 091 152 213 244 305 366 31

JULIAN DATE CALENDAR
FOR LEAP YEARS ONLY

USE IN 2004, 2008, 2012, 2016, 2020, 2024, ETC.
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1. Final artwork - final approved and stamped print-outs of artwork component(s). If blueprints were
obtained, the respective blueprint should be stapled to back of respective art printout. If blueprint
is bigger than 81/2 x 11, fold them in half with the final approved artwork showing on top. Make
sure to remove any "X" revision levels from final artwork.

5 
4 

3 
2 

AR T  REQUEST 
NUMBER P ACKAGING  SERVICES  

AR T  REQUEST  FOLDER 

REFERENCE CAT. NO.  

PROJECT  NAME 

SELF  
MF G PURCH EC O 

KEY :    F  =  FILM          FTP  =  DIGI TA L F  ILE TRANSFER          DFM  =  DIGI TA L F  ILE MEDIA *REQUIRED  DA TE  =  DA TE  FOR  AR TWORK  TO  BE  COMPLETED,   APPROVED  AND  FOR  FILM/DIGI TA L  FILES  TO  BE  READY 

QTY 
OUTPUT 

F DELIVER TO 
COST 

(EACH) PO 
DWG  
FILE PA RT NUMBERS 

*REQUIRED DA TE: REQUESTED BY : 

F 
T 
P 

D 
F 
M 

C 
O 
S 
T 

D 
O 
N 
E Letter  to  V endor 

E-Mail  to  
Pur chasing  Dept . 

E-Mail  to  
Manufacturing  Plan t 

CONFIRMA TION DESIGN PURCHASING 

INSTRUCTION  SHEET 
TRANSLA TIONS 

SPECIAL NOTES 

FRENCH 

SP ANISH 

DA TE 

DA TE 

1 

Sequence for Job Folder Assembly

Misc. Items
Artwork Mark-ups
PDP Forms & BOMs
Approvals
Final Artwork1

2
3

4
5

Final Artwork1

con’t

Assembly:
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BOM

PDP Form (Orig.)

2. Approvals - staple all approvals as shown.

Artwork Printout for Rev. level X0

Latest email 
date toward
front

(staple all
approvals in
lefthand corner 
of artwork 
printout)

2a

Approvals for Rev. level X0 

Artwork Printout for Rev. level X1

Latest email  and
artwork printout
date toward front

(staple all approvals 
in lefthand corner of 
artwork printout)

2b

Approvals for Rev. level X1 

Note: All rev. rounds
should be stapled latest
date forward and follow
chronological
sequence.

con’t

3. PDP Forms and BOMs - staple PDP project e-mail and form together as shown.

PDP Forms
and BOMs

3

Project Email (Orig.)

4. Artwork Mark-Ups - staple all critical artwork mark-ups used during development of art with latest in front.

5. Misc Items - staple any other misc and relevant print-outs together in date order with latest date on top.

PDP Form (Rev.)

Project Email (Rev.)

Project Email 
toward 
front

(staple BOM,
Project Email 
& PDP form
in lefthand
corner of
printouts)

Latest PDP Form
toward front

If a new revision to the form is
submitted place that in front of
the previous PDP Form and the
previous Project Email

Note: All rev. rounds
should be stapled latest
date forward and follow
chronological
sequence.
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Before any folder can be processed it must have 
all of the following completed:
• All approvals listed on the folder 
• Artwork checklist completed by graphic artists and peer review
• Make notations on the back of folder and in the Artwork Spec box 

when dealing with Julian Date changes. 
Note: Please be sure that latest Julian dated artwork 
printout is in front. 

• Film checklist completed when applicable
• Files put on the server
• Folder signed by peer reviewer and graphic artist
• Final notation dated that all of the above has been completed    

Processing of Job Folder
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Setting up for FTP transferSetting up for FTP transfer

levpac99372

To ACCESS the uploaded files through the internet, enter
the information below. This info goes to the vendor.

ftp://levpacuser1:levpac45971@ftp.leviton.com/

ftp://levpacuser2:levpac58604@ftp.leviton.com/

ftp://levpacuser3:levpac34910@ftp.leviton.com/

ftp://levpacuser4:levpac92375@ftp.leviton.com/

Fetch 5.0.5
LEVITON FTP INFORMATION

We currently have 4 folders to use for FTP access, Packaging1, Packaging2, Packaging3 and
Packaging4. We decided to set up a folder for vendors to have access to upload and download
files. We added an additional folder, Packaging5, to use for our vendors.

The information for the vendors to log on to Packaging5 is:
Hostname: ftp.leviton.com
Username: LevPacUser5
Password: levpac23874

With the information above, the vendors will have read and write capabilities for Packaging5 ONLY.
LevPacAdmin has read and write capabilities for all 5 folders.

Please continue to only use the folders Packaging1, Packaging2, Packaging3 and Packaging4 to
upload artwork.
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Fetch 5.0.5
PREFERENCES

Setting up for FTP transferSetting up for FTP transfer
PreferencesPreferences
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Server TutorialServer Tutorial

Note: Any files that are backed up must be completed and the final versions used for production.

1. Files should be properly flightchecked and include all proper file extensions. Your flightchecked folder will consist of the main
file and all fonts and images linked to main file.

2. (using Stuffit) Stuff FINAL flightchecked file as a self extracting .sit file.

3. A final PDF with fonts embedded must be included for quick reference to the file (See Example 1A).

4. Log onto the server afp://w2lnpkg1 and go to PRODUCT COMPLETE folder. Find correct folder in which file(s) should be placed
and put on server (See Example 1B).

5. If there is no existing folder for the CAT. # you are looking for, make a new folder.

6. Any new PK Die Lines, Photos, Logos, Line Art etc. should be put into the PACKAGING SERVICES GRAPHICS Folder. See
corresponding folder for proper filing. Line Art goes into Line art folder and Photos go into color corrected photos folder etc.
(See Example 2).

FINAL Stuffed file and PDF

Correct folder 

4XXX

3XXX

2XXX

1XXX

Example 1A

Example 1B

Example 2



System Internal SAN - SAN assigned to use internally within Leviton for production of finished good (FG).

System External SAN - SAN assigned to use externally for customers.

If FG is multi-sourced - there will be more than one Internal SAN associated to same External SAN

If FG is NOT multi-sourced - there will be only one internal SAN associated to an External SAN.

Parent SAN - the Leviton Internal SAN that is used as the template for information that is passed on to Child SANs.

Child SAN - one or more Leviton Internal SANs that are used to produce the same Parent SAN using the exact information
as the Parent SAN, except for mfg location.

All artwork must show the 3 digit alphanumeric Internal SAN. Vertically along UPC without violation of UPC 1/8" minimum
quiet zones.

The Parent SAN information is the one used to generate the barcode (the Child SAN "should" have the same information
already in the system).
CAUTION: MULTI-SOURCE ART SHOULD NOT BE CREATED UNTIL MULTI-SOURCE RELATIONSHIP IS ASSIGNED BY
MRP. See M/S Indicator for assignment (see example 1A).

The packaging part number SAN should always be the Internal SAN No. (see example 1B)

A. On the Item Description Inquiry Screen for L10-12771, the multi-source indicator is blank, therefore, this item is NOT multi-
sourced (see example 1A &1B).
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Multi-Sourcing 7

M/S

Multi-Source Indicator

System Internal SAN

EXAMPLE 1A
Item Description Inquiry Screen for L10-12771

System External SAN

 

R4

Assorted Wire Connectors
Ideal For: Multiple wire
connections, wiring switches and
wall outlets, and hanging fixtures

WARNING: TO AVOID FIRE,
SHOCK, OR DEATH; TURN OFF
POWER AT CIRCUIT BREAKER
OR FUSE AND TEST THAT
POWER IS OFF BEFORE
INSTALLING OR REMOVING WIRE CONNECTORS! 
CAUTION: Use this device only with copper or copper clad
wire. With aluminum wire use only devices marked CO/ALR
or CU/AL. 

Surtido de Conectores de Alambre
Ideal Para: Conexiones de alambres múltiples, cableado de
apagadores y contactos de pared, cajas de salida y
artefactos que se cuelgan

ADVERTENCIA: PARA EVITAR DESCARGA
ELECTRICA, FUEGO, O MUERTE, INTERRUMPA EL
PASO DE ENERGIA MEDIANTE EL INTERRUPTOR DE
CIRCUITO O FUSIBLE. ¡ASEGURESE DE QUE AMBAS
MITADES DEL CONTACTO NO ESTAN ENERGIZADAS
ANTES DE INSTALAR O REMOVER LOS CONECTORES
DE CABLE!
PRECAUCION: Use este producto sólo con cable de
cobre o revestido de cobre. Para cable de aluminio use sólo
productos marcados con el símbolo CO/ALR o CU/AL.

Instructions Enclosed
Instructivo Incluido

C
I-

L0
0-

12
77

1-
11

A
P

K
-9

73
39

-0
0-

00
-0

0

Manufactured and Exported By / Manufacturado y Exportado Por:
Leviton Mfg. Co., Inc. 59-25 Little Neck Parkway, Little Neck, N.Y. 11362-2591
Imported For / Importado Para: Leviton, S.A. de C.V., RFC LEV-920526651, 
Arista 54-A, México 11270 D.F., México, Tel. 555 386-0073
Made in U.S.A. / Hecho en E.U.A.

TO BE INSTALLED AND/OR USED IN ACCORDANCE WITH
APPROPRIATE ELECTRICAL CODES 
AND REGULATIONS / 
PARA INSTALARSE 
Y/O USARSE DE 
ACUERDO CON 
LOS CODIGOS 
ELECTRICOS Y 
NORMAS APROPIADAS

L0
0-

12
77

1

Product Information Hotline
Línea Automática de Información
1-800-824-3005 / www.leviton.com

L00

Artwork 
External SAN

Artwork
Internal SAN
1/8" Minimum 
Quiet Zone

L1
0-

12
77

1

L10

C
I-

L1
0-

12
77

1-
11

A
P

K
-9

73
39

-0
0-

00
-0

0 Packaging
Part No.

Artwork for L10-12771
EXAMPLE 1B
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GFCI, SMARTLOCK®

W/WALLPLATE
RECEPTACLE 20A-125V
FEED-THROUGH 20A-125V

DDFT SMARTLOCKMD AVEC
PLAQUE PRISE DE 20  A/125  V, 
20  A/125  V EN PASSAGE
CONTINU

ICFT, SMARTLOCK®

C/ PLACA DE PARED
RECEPTACULO 20A-125V
ALIMENTACION 20A-125V

QTY//QTE CAT

COLOR/COULEUR SAN

8899-SGW
WHITE / BLANC / BLANCO 012

1

UL
LISTED





01
2

G

5-20R

Artwork for 012-08899
EXAMPLE 2C

B. On the Item Description Inquiry Screen for Internal SAN
012-08899, the multi-source indicator is filled in, therefore, 
this item IS multi-sourced. Screen indicates INT SAN 012 
is the CHILD SAN. (see example 2A). For this CHILD SAN
the artwork for the INT & EXT SANS are the same as per
the system. (see example 2A, 2B, 2C).

Item Description Inquiry Screen for 912-08899

M/S

Multi-Source Indicator

Packaging Data Screen for 912-08899

Packaging Data Screen for 012-08899Item Description Inquiry Screen for 012-08899

EXAMPLE 2A

M/S

EXAMPLE 3A

Artwork
External SAN

Artwork
Internal SAN
1/8" Quiet Zone

GFCI, SMARTLOCK®

W/WALLPLATE
RECEPTACLE 20A-125V
FEED-THROUGH 20A-125V

DDFT SMARTLOCKMD AVEC
PLAQUE PRISE DE 20  A/125  V, 
20  A/125  V EN PASSAGE
CONTINU

ICFT, SMARTLOCK®

C/ PLACA DE PARED
RECEPTACULO 20A-125V
ALIMENTACION 20A-125V

QTY//QTE CAT

COLOR/COULEUR SAN

8899-SGW
WHITE / BLANC / BLANCO 012

1

UL
LISTED





91
2

G

5-20R

Artwork for 912-08899
EXAMPLE 3C

EXAMPLE 2B

EXAMPLE 3BMulti-Source Indicator

Artwork
External SAN

Artwork
Internal SAN
1/8" Quiet Zone

C. On the Item Description Inquiry Screen for Internal SAN
912-08899, the multi-source indicator is filled in, therefore, 
this item IS multi-sourced. Screen indicates INT SAN 912 
is the PARENT SAN. (see example 3A). For this PARENT 
SAN the artwork for the INT & EXT SANS are different as 
per the system. (see example 3A, 3B, 3C).
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QTY
QTE
CANT

EXT

INTINNER
INT

COLOR/COULEUR

3.
00

0"

4.875"

875-274100
975

GRAY
GRIS

2-WIRE TO 3-WIRE
GROUNDING ADAPTER

ADAPTADOR PARA CLAVIJAS
CON CONEXION A TIERRA

10 15A-125V AC/CA

LA-975-00274-14A

LISTED

CURRENT TAP


258B

UL

9
7

5

G

W

5-15R

External San

Internal San

External San
Barcode

Internal San
Multisource

Barcode

Multisource LA Label

3.500"

2.875"

10
QTY/QTE/CANT

COLOR/COULEUR SAN

CAT

2-WIRE TO 3-WIRE
GROUNDING ADAPTER

ADAPTADOR PARA CLAVIJAS
CON CONEXION A TIERRA T

B
-9

7
5
-0

0
2
7
4
-1

4
A

9
7
5

GRAY/GRIS 875

274

15A-125V AC/CA

LISTED

CURRENT TAP


258B

UL

G

W

5-15R

External San
Barcode

External San

Internal San

Multisource TB Label
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Import /Export 8Flow chart - Use this chart to determine the proper import/Export statement.
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When determining the proper Import/Export statement you should always use the chart. Anything that is in Mexico should
always state Assemble in Mexico. 

Exceptions to the rule - If a product is 100% made in Mexico you can use Made in Mexico. This is very rare. 

If a product comes from many countries i.e. (connectors). You must ensure  you contact Import/Export Dept. Karen Kosel
for verification. 

Anything that is not clear the Import/Export Dept. must be contacted via email so it is documented.
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Warning Statments 9
All Warning statements can be found on the Server afp://w2lnpkg1. See Packaging Service Graphics
Standards statements folder.
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Instruction Sheets 10Instruction Sheet TemplatesInstruction Sheet Templates

Instruction sheet templates can be found on the Graphics Server in a Folder named “INSTRUCTION SHEETS”
and within a subfolder named “IS Templates”. Please see the snapshots below as reference only. Use the
actual templates when formatting a new instruction sheet.

Single Pole (One location) or 3-Way (Multi-location) 
Incandescent Dimmer

Cat. No. ACIØ6-1L, 600W (Lighted) 
120VAC, 60Hz

INSTALLATION INSTRUCTIONS

Bl Single-Pole Wiring Application:

DI-000-ACI06-00C

Tools needed to install your Dimmer:

Slotted/Phillips Screwdriver Electrical Tape 
Pliers   Pencil 
Cutters   Ruler

Installing Dimmer by itself or with other devices:

If installing Dimmer in a single device application, proceed with the 
INSTALLING YOUR DIMMER section. If installing Dimmer in a multi-
device application, proceed as follows:

MULTI-DEVICE APPLICATION

In multi-dimmer installations, the reduction of the dimmer’s capacity 
is required. Breaking off fins is not required on this device. Refer to 
the chart for maximum load per dimmer.

INSTALLING YOUR DIMMER

NOTE: Use check boxes       when Steps are completed. 

WARNING: TO AVOID FIRE, SHOCK, OR DEATH; 
TURN OFF POWER at circuit breaker or fuse and test  
that power is off before wiring!

Identifying your wiring application (most 
common):
NOTE: If the wiring in the wall box does not resemble any 
of these configurations, consult a qualified electrician.

Step 2

Step 1

Step 3

ONOFF

ONOFF

ONOFF

ONOFF

ONOFF

ONOFF

ONOFFONOFF

ONOFF

ONOFF

ONOFF

ONOFF

2

4

1

3

2

4

1

5

3

3-Way
1. Line or Load (See important 

instruction below)
2. Neutral
3. Ground
4. First Traveler – note color
5. Second Traveler – note color 

NOTE: For matching remote w/LEDs 
installation, the First Traveler becomes 
Line Hot.

       More than  
  Cat. No.  Single Two Devices 2 Devices

   ACIØ6   600W     600W 500W

MAXIMUM LOAD PER DIMMER FOR MULTI-DEVICE

Preparing and connecting wires:
This dimmer can be wired using side wire terminal screws 
or through backwire openings. Choose appropriate wire 
stripping specifications accordingly.

Cut
(if necessary)

Installing your Alignment Plate:Step 4

  

WIRING DIMMER:
Connect wires per WIRING DIAGRAM as follows:
• Green or bare copper wire in wall box to Green terminal screw.
• Line Hot wall box wire to terminal screw marked “BL”.
• Load wall box wire to terminal screw marked “RD”.
• Dimmer terminal screw marked “YL/RD” should have Red 

insulation label affixed.  
NOTE: If insulating label is not affixed to terminal screw marked 
“YL/RD”, use electrical tape to cover.

• Proceed to Step 6.

Step 5a

Hot (Black)

Neutral (White)

Load

Dimmer

BL 

Black

White

RD

Green
Ground
Screw

Line
120 VAC, 60Hz

YL/RD 

Use Terminal for 3-Way or
More Applications Only.
For Single-Pole Applications,
Do Not Remove This Label.

BL 

YL/RD RD 

Terminal
Screw marked

Black (BL)

Terminal 
Screw marked 

Red (RD)

Termonal 
Screw marked 

Yellow/Red 
(YL/RD)

Terminal Label:
Use terminal for 3-Way or More Applications Only.
For Single-Pole Applications, Do Not Remove This
Label.

4 

3 

2 1 

 

Side Wire Connection
Side wire terminals accept 
#14 AWG solid copper wire only.

Back Wire (either hole may 
be used)
Back wire openings use #14-12 
AWG solid copper wire only.

• Make sure that the ends of the wires from the wall box are straight 
(cut if necessary).

• Remove insulation from each wire in the wall box as shown.

WARNINGS AND CAUTIONS:
• To be installed and/or used in accordance with appropriate electrical codes and regulations.

• If you are unsure about any part of these instructions, consult a qualified electrician.

• To avoid overheating and possible damage to this device and other equipment, do not install to control a receptacle, fluorescent lighting, a motor- or a transformer- 
 operated appliance.

• Use with incandescent or 120V halogen fixtures only.

• Acenti™ dimmers are not compatible with standard 3-way or 4-way switches. They must be used with compatible Acenti™ remotes for multi-location dimming.

• Use only one (1) dimmer in a multi-location circuit with up to 9 coordinating remotes without LEDs or up to 4 matching remotes with LEDs. The remote(s) will turn the 
light on at the brightness level selected at the dimmer.

WARNINGS AND CAUTIONS:
• Dimmer may not operate with dioded lamps (Sylvania Designer 16™ or Philips PAR-16™).

• Total minimum load must exceed 40W.

• Dimmer may feel warm to the touch during normal operation.

• Recommended minimum wall box depth is 2-1/2”.

• Maximum wire length from dimmer to all installed remotes cannot exceed 300 ft.

• Disconnect power at circuit breaker or fuse when servicing, installing or removing fixture.

• Use this device only with copper or copper clad wire. With aluminum wire use only devices marked CO/ALR or CU/AL.

Single-Pole
1. Line (Hot) 
2. Neutral  
3. Ground 
4. Load 

Step 3 cont’d

Strip Gage (measure 
bare wire here or use 
gage on back of the 
dimmer)

• For Single-Pole Application, go to Step 5a.
• For 3-Way Coordinating Remote (no LEDs) Application, go to 

Step 5b.
• For 3-Way Matching Remote (with LEDs) Application, go to 

Step 5c.

IMPORTANT: For 3-Way applications, note that one of the screw 
terminals from the old switch being removed will usually be a different 
color (Black) or labeled Common. Tag that wire with electrical tape and 
identify as the common (Line or Load) in both the dimmer wall box and 
remote wall box.

5/8”
(1.6 cm)

Important Notice for Installer

To achieve proper aesthetic installation of the Acenti products, 
the wall surface surrounding the wall box opening must be 
fairly flat and free of irregularities. The wall box must be 
level and recessed or flush to the wall surface. The Acenti 
installation system allows for adjustments that will correct 
minor flaws that may be present in the installation area.

This device must be installed with the Acenti™ Alignment 
Plate. The Alignment Plate is packaged with the Acenti™ 
Wallplate, which is sold separately from this device.

The Alignment Plate will function properly only if it is mounted 
to a flat wall surface as described above.

• Leviton recommends to temporarily position the Alignment 
Plate prior to wiring the device. If the wall box wires extend 
at least 6 inches out of the wall box, it is also possible to 
install the Alignment Plate after the device has been wired 
(refer to Wallplate instruction sheet).

• The Alignment Plate must be installed with the tab towards 
the bottom.

• Leviton recommends the following 3 methods to 
temporarily hold the Alignment Plate – use of device 
mounting screw, use of wall box wires, or use of electrical 
tape (refer to the following figures):

  

Alignment Plate Held By Tape

TOP

Electrical 
Tape

Alignment Plate Held By Wires

TOP

Alignment Plate Held By Mounting Screw

TOP

Mounting 
Screw

Alignment 
Plate

A

B

C

Step 4 cont’d

5/8”
(1.6 cm)

       
 

     
 

 

  

DI-000-ACI06-00C
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   ACIØ    600W     600W 500W

M      

   
          

       
  

    

  

 
      

            
          
         
         

    
           

     
    

 

  
    

     

     
 

     
    

               
  

           

WARNINGS AND CAUTIONS:
• To be installed and/or used in accordance with appropriate electrical codes and regulations.

• If you are unsure about any part of these instructions, consult a qualified electrician.

• To avoid overheating and possible damage to this device and other equipment, do not install to control a receptacle, fluorescent lighting, a motor- or a transformer- 
 operated appliance.

• Use with incandescent or 120V halogen fixtures only.

• Acenti™ dimmers are not compatible with standard 3-way or 4-way switches. They must be used with compatible Acenti™ remotes for multi-location dimming.

• Use only one (1) dimmer in a multi-location circuit with up to 9 coordinating remotes without LEDs or up to 4 matching remotes with LEDs. The remote(s) will turn the 
l          

  
             

      

          

       

             

             

                    

   
   
  
  

  

   
     
     

       
          

 
          

 

          
            

            
              
  

 

   

         
          

           
           

        
         

         
         

       

           
       

        
            

              
          
    

           
 

        
         

           
     

  

A     

 

    

     

 

 

  

 

Installing and 
Testing a GFCI

Receptacle

Please read this leaflet 
completely before getting started.

UL
LISTED

PK-93370-10-00-2B-X0

CAUTION!

• To prevent severe shock or 
electrocution always turn the power 
OFF at the service panel before 
working with wiring.

• Use this GFCI with copper or copper-
clad wire. Do not use it with aluminum 
wire.

• Do not install this GFCI receptacle 
on a circuit that powers life support 
equipment because if the GFCI trips it 
will shut down the equipment.

• For installation in wet locations, 
protect the GFCI receptacle with a 
weatherproof cover that will keep both 
the receptacle and any plugs dry.

• Must be installed in accordance with 
national and local electrical codes.

1. What is a GFCI?

A GFCI receptacle is different from  
conventional receptacles. In the event of a 
ground fault, a GFCI will trip and quickly stop  
the flow of electricity to prevent serious injury.

Definition of a ground fault:
Instead of following its normal safe path, 
electricity passes through a person's body to 
reach the ground. For example, a defective 
appliance can cause a ground fault.

A GFCI receptacle does NOT protect against 
circuit overloads, short circuits, or shocks. For 
example, you can still be shocked if you touch 
bare wires while standing on a non-conducting 
surface, such as a wood floor.

GFCI's contain a lockout feature that will  
prevent RESET if:

• There is no power being supplied to the   
 GFCI.
• The GFCI is miswired due to reversal of the  
 LINE and LOAD leads.
• The GFCI cannot pass its internal test,   
 indicating that it may not be able to provide  
 protection in the event of a ground fault.

2. The GFCI's features

3. Should you install it?

Installing a GFCI receptacle can be more 
complicated than installing a conventional 
receptacle.

Make sure that you:

•  Understand basic wiring principles and 
techniques

• Can interpret wiring diagrams

• Have circuit wiring experience

•  Are prepared to take a few minutes to test 
your work, making sure that you have wired 
the GFCI receptacle correctly

4. LINE vs. LOAD

A cable consists of 2 or 3 wires.

         Cable    Wires

LINE cable:
Delivers power from the service panel (breaker 
panel or fuse box) to the GFCI. If there is only 
one cable entering the electrical box, it is the 
LINE cable. This cable should be connected to 
the GFCI's LINE terminals only.

LOAD cable:
Delivers power from the GFCI to another 
receptacle in the circuit. This cable should be 
connected to the GFCI's LOAD terminals only. 
The LOAD terminals are under the yellow  
sticker. Do NOT remove the sticker at this time.

5. Turn the power OFF

Plug an electrical device, such as a lamp or 
radio, into the receptacle on which you are 
working. Turn the lamp or radio ON. Then, go  
to the service panel. Find the breaker or fuse 
that protects that receptacle. Place the breaker 
in the OFF position or completely remove the 
fuse. The lamp or radio must turn OFF.

Next, plug in and turn ON the lamp or radio at  
the receptacle's other outlet to make sure the 
power is OFF at both outlets. If the power is not 
OFF, stop work and call an electrician to  
complete the installation.

6. Identify cables/wires

Important:
DO NOT install the GFCI receptacle in an 
electrical box containing (a) more than four (4) 
wires (not including the grounding wires) or  
(b) cables with more than two (2) wires (not 
including the grounding wire). Contact a  
qualified electrician if either (a) or (b) are true.

If you are replacing an old receptacle, pull it out 
of the electrical box without disconnecting the 
wires.

• If you see one cable (2-3 wires), it is the  
LINE cable. The receptacle is probably in 
position C (see diagram to the right).  
Remove the receptacle and go to step 7A.

• If you see two cables (4-6 wires), the 
receptacle is probably in position A or B  
(see diagram to the right). Follow steps a-e 
of the procedure to the right.

Procedure: box with two (2) cables (4-6 wires):

(a) Detach one cable's white wire and hot   
wires from the receptacle and cap each  
one separately with a wire connector.  
Make sure that they are from the same 
cable.

(b) Re-install the receptacle in the electrical 
box, attach faceplate, then turn the power 
ON at the service panel.

(c) Determine if power is flowing to the 
receptacle. If so, the capped wires are the 
LOAD wires. If not, the capped wires are 
the LINE wires.

(d) Turn the power OFF at the service panel, 
label the LINE and LOAD wires, then 
remove the receptacle.

(e) Go to step 7B.

Placement in circuit:
The GFCI's place in the circuit determines if 
it protects other receptacles in the circuit.

Sample circuit:

Placing the GFCI in position A will also 
provide protection to "load side"  
receptacles B and C. On the other hand, 
placing the GFCI in position C will not 
provide protection to receptacles A or B. 
Remember that receptacles A, B, and C  
can be in different rooms.

LINE
A B C

LOAD

Service
Panel

LOAD

LINE LINE

RESETRESET

TESTTEST

T
E

S
T M
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T
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FRONT VIEW

Receptacle

Outlet

TEST button: 
See step 8

LED
Indicator
Light

RESET 
button:  
See step 8

Mounting 
Bracket

Outlet

Cu

LIGNE
LINE

W
H

IT
E

 W
IR

E

US Pat.
6,246,558
6,864,766

WARNING
Warranty void if
unit is opened

or tampered with

ATTENTION
Garantie annulee

si ouvert, ou
dans les cas

mauvaise utilisation

MADE IN XXXXXXX

Back wire
strip gage

Gabarit de denudage
pour filage arriere

F
IL

 B
L

A
N

C H
O

T
 W

IR
E

F
IL

 A
C

T
IF

CHARGE
LOAD

AL

BACK VIEW
Grounding Terminal (Green):
Connection for bare
copper or green wire

LINE
White terminal (Silver):
Connection for the LINE 
cable's white wire

LOAD
White terminal (Silver):
Connection for the LOAD 
cable's white wire

LINE
Hot terminal (Brass):
Connection for the LINE 
cable's black wire

A yellow sticker 
covers the LOAD 
terminals. Do not 
remove the sticker at 
this time.

LOAD
Hot terminal (Brass):
Connection for the LOAD 
cable's black wire

Screw (terminal) colors:
Green = grounding terminal
Silver = WHITE terminals
Brass = HOT terminals

Back wire grounding hole
(Green): Connection for
bare copper or green wire

Back wire holes

Installing and 
Testing a GFCI

Receptacle
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FEATURES
• Regulated 24VDC, 150mA output current (120mA for OSP15)
• Mounts inside Fluorescent Ballast cavity
• Mounts inside or outside Junction Box
• Teflon coated Class II wires for plenum wiring

RATINGS
Part Number HVAC Relay Power Input1 Power Output2

OSP20-0D0 No 120-277VAC, 60Hz 24VDC, 150mA 3.6W
OSP20-RD0 Yes 120-277VAC, 60Hz 24VDC, 150mA 3.6W
OSP15-R30 Yes 347VAC, 60Hz 324VDC, 120mA 3.0W
OSA20-R00 Yes 24VDC, 50mA-1.2W N/A
1 Input voltage tolerance 10% Frequency tolerance 5%.
2 Output voltage tolerance 15%, Output voltage listed at nominal.
3 Voltage range for the OSP15-R30 is 19-27VDC based on load and temperature conditions.

DESCRIPTION
The power pack contains a power supply, a load switching relay and on some models, a HVAC relay. The
power supply provides Class II low-voltage power for OSCxx, OSWxx, ODCxx, andODWxx Series
Occupancy Sensors. The OSP power packs can also supply power to the OSA20, Add-A-Relay. The relay in
the power pack is controlled by the occupancy sensors connected via the 22 Gauge Blue “occupancy” wire.
Multiple occupancy sensors can be connected to a single power pack in order to fully cover an area.
The power packs include zero cross switching circuitry to minimize inrush current associated with
incandescent and electronic ballasts. This reduces wear and tear on the relay contacts making the power
pack last longer.
Application Notes:
Loads that exceed the ratings of a single power pack can be connected to an Add-A-Relay, which is powered
from the low-voltage output of the power pack (OSPxx). The Add-A-Relay contains the load switching and
HVAC relays and is powered by an OSPxx Power Pack.
1. When a lighting load exceeds a single power pack’s rating, the load can be split between multiple power packs.
    The low voltage occupancy input (Blue wire) and DC return (Black wires) of the power packs must be
    connected together for all power packs to operate together as one. Connect the Blue (occupancy) wires of all
    power packs and sensors together. Connect the Black (return) wires of all power packs and sensors together.
    Connect the Red (+24VDC) wires of the sensors to the Red wires of only one power pack. Never connect the
    Red (+24VDC) wires of two different power packs together.
2. When more sensors are required than one power pack can supply, multiple power packs can be used to supply
    power to the occupancy sensor, but not switch any load. The primary power pack is the power pack switching
    the load. The secondary power packs only provide low voltage power to the occupancy sensor(s). Connect as
    many sensors to the primary power pack as possible (see current capacity section below), by connecting the
    Red wires of the sensors to the Red wire (+24VDC) of the primary power pack. Connect the Red wires
    (+24VDC) of the remaining sensors to the Red wires of the secondary power pack. Connect the Black (return)
    wires of all power packs and all sensors together. Connect the Blue (occupancy) wire of all sensors together to
    the Blue wire (occupancy) of the primary power pack. Never connect the Red (+24VDC) wires of two different
    power packs together.

FCC COMPLIANCE STATEMENT (OSP20 Only)
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be required to correct the
interference at his own expense.

LOW-VOLTAGE CURRENT CAPACITY

Occupancy Sensor
Power Pack

Cat. Nos.
OSP20-0D0

OSP20-RD0 (with HVAC relay)
Load Ratings:

20A, 2400W @ 120V, 60Hz – Incandescent
20A, 2400VA @ 120V, 60Hz – Fluorescent
20A, 5540VA @ 277V, 60Hz – Fluorescent

1 HP @ 120VAC – Motor Load
2 HP @ 240V, 60Hz – Motor Load

0.5A 125V, 1A 30VDC – HVAC Relay

Cat. No.
OSP15-R30 (with HVAC relay)

 Load Ratings:
15A, 5200VA @ 347V, 60Hz – Fluorescent

0.5A 125V, 1A 30VDC – HVAC Relay

Occupancy Sensor Add-A-Relay
Cat. No.

OSA20-R00 (with HVAC relay)
Load Ratings:

15A, 1800W @ 120V, 60Hz – Incandescent
20A, 2400VA @ 120V, 60Hz – Fluorescent
20A, 5540VA @ 277V, 60Hz – Fluorescent
15A, 5200VA @ 347V, 60Hz – Fluorescent

1 HP @ 120VAC – Motor Load
2 HP @ 240V, 60Hz – Motor Load

0.5A 125V, 1A 30VDC – HVAC Relay

For use with OSCxx, OSWxx, ODCxx,
and ODWxx Occupancy Sensors

INSTALLATION INSTRUCTIONS

LIMITED 5 YEAR WARRANTY AND EXCLUSIONS
Leviton warrants to the original consumer purchaser and not
for the benefit of anyone else that this product at the time of
its sale by Leviton is free of defects in materials and
workmanship under normal and proper use for five years from
the purchase date. Leviton’s only obligation is to correct such
defects by repair or replacement, at its option, if within such
five year period the product is returned prepaid, with proof of
purchase date, and a description of the problem to Leviton
Manufacturing Co., Inc., Att: Quality Assurance
Department, 59-25 Little Neck Parkway, Little Neck, New
York 11362-2591. This warranty excludes and there is
disclaimed liability for labor for removal of this product or
reinstallation. This warranty is void if this product is installed
improperly or in an improper environment, overloaded,
misused, opened, abused, or altered in any manner, or is not
used under normal operating conditions or not in accordance
with any labels or instructions. There are no other or implied
warranties of any kind, including merchantability and fitness
for a particular purpose, but if any implied warranty is required
by the applicable jurisdiction, the duration of any such implied
warranty, including merchantability and fitness for a particular
purpose, is limited to five years. Leviton is not liable for
incidental, indirect, special, or consequential damages,
including without limitation, damage to, or loss of use of, any
equipment, lost sales or profits or delay or failure to perform
this warranty obligation. The remedies provided herein are the
exclusive remedies under this warranty, whether based on
contract, tort or otherwise.

For Technical Assistance Call:
1-800-824-3005 (U.S.A. Only)

www.leviton.com

PK-93960-10-00-0C
INSTALLATION INSTRUCTIONS

WARNING: TO BE INSTALLED AND/OR USED IN ACCORDANCE WITH APPROPRIATE ELECTRICAL
CODES AND REGULATIONS.
WARNING: IF YOU ARE NOT SURE ABOUT ANY PART OF THESE INSTRUCTIONS, CONSULT A
QUALIFIED ELECTRICIAN.
OTHER CAUTIONS:
1. DISCONNECT POWER WHEN SERVICING FIXTURE OR CHANGING LAMPS.
2. USE THIS DEVICE ONLY WITH COPPER OR COPPER CLAD WIRE. WITH ALUMINUM WIRE USE

ONLY DEVICES MARKED CO/ALR OR CU/AL.
TO INSTALL:
1. WARNING: TO AVOID FIRE, SHOCK, OR DEATH; TURN OFF POWER AT CIRCUIT BREAKER OR

FUSE AND TEST THAT POWER IS OFF BEFORE WIRING!
2. Mount power pack per desired application:

A. To mount outside 4"x4" junction box using 2" EMT nipple, refer to Figure 1. Wire per Step 3A and 3B.
B. To mount inside 4"x4" junction box, refer Figure 2. Wire per Step 3A and 3B.

• Ensure that conduit/cable entry clamp is located in corner of junction box.
• Dress wires to provide enough clearance when device is installed.

CAUTION: Low-voltage wires must also be dressed so they are separate from the high voltage (Class I)
conductors. Refer to local building codes for the appropriate installation requirements for the low-
voltage wiring. Jacketing over the low-voltage wires may be required to provide appropriate insulation
from the high-voltage wiring.
C. To mount inside ballast cavity of light fixture, refer Figure 3A. Wire per Step 3A and 3B.
CAUTION: Low-voltage wires must also be dressed so they are separate from the high voltage (Class I)
conductors. Refer to local building codes for the appropriate installation requirements for the low-
voltage wiring. Jacketing over the low-voltage wires may be required to provide appropriate insulation
from the high-voltage wiring.
D. To mount outside ballast cavity of light fixture, refer Figure 3. Wire per Step 3A and 3B.

3A. Line Voltage Wiring: Remove 5/8" (1.6 cm) of insulation from each circuit conductor. Make sure that
ends of conductors are straight. Connect lead wires from Power Pack to LINE circuit per appropriate
WIRING DIAGRAM as follows: Twist strands of each lead tightly and, with circuit conductors push firmly
into appropriate wire connector. Screw connectors on clockwise making sure that no bare conductor
shows below the wire connectors. Secure each connector with electrical tape.

3B. Class II and HVAC Wiring: Connect Low-Voltage wires from Power Pack to Sensor per appropriate
WIRING DIAGRAM as follows: Twist strands of each lead tightly and, with circuit conductors, push firmly
into appropriate wire connector. Screw connectors on clockwise making sure that no bare conductor
shows below the wire connectors. Secure each connector with electrical tape.

4. Refer to sensor Installation Instructions for further details.
5. Restore power at circuit breaker or fuse. INSTALLATION IS COMPLETE.

WIRE DESIGNATIONS

PK-93960-10-00-0C

Signal Name Color Gauge

  Line Voltage Wires

  Line 120/277V (OSP20-xx0) Black 18AWG
  Line 347V (OSP15)
  Neutral White 18AWG
  Load Blue 14AWG
  Load Blue 14AWG
  Class II Wires
  Power (24VDC) Red 22AWG
  Return Black 22AWG
  Occupancy Blue 22AWG
  HVAC Wires
  HVAC Common Green 22AWG
  HVAC NO (Normally Open) Brown/White 22AWG
  HVAC NC (Normally Closed) Brown 22AWG

All wires rated at 105° C, 600V insulation.
Class II wires are Teflon coated, for plenum applications.

HVAC wiring is Class I and Class II rated.

NOTE: Add-a-Relay current consumption = 50mA per unit.

Total Number of
Sensor

+ Total Number of
Add-a-Relays

≤ 150mA

Total Number of
Sensor

+ Total Number of
Add-a-Relays

≤ 120mA

For OSP20

For OSP15

       
    
     

       

    
  
  

  
 

       
         
             

                  
            

                
                

                 
             

               
  

 
                  

               
         

                   
    The low voltage occupancy input (Blue wire) and DC return (Black wires) of the power packs must be
    connected together for all power packs to operate together as one. Connect the Blue (occupancy) wires of all
    power packs and sensors together. Connect the Black (return) wires of all power packs and sensors together.
    Connect the Red (+24VDC) wires of the sensors to the Red wires of only one power pack. Never connect the
    Red (+24VDC) wires of two different power packs together.
2                    
                      
    the load. The secondary power packs only provide low voltage power to the occupancy sensor(s). Connect as
    many sensors to the primary power pack as possible (see current capacity section below), by connecting the
    Red wires of the sensors to the Red wire (+24VDC) of the primary power pack. Connect the Red wires
    (+24VDC) of the remaining sensors to the Red wires of the secondary power pack. Connect the Black (return)
    wires of all power packs and all sensors together. Connect the Blue (occupancy) wire of all sensors together to
    the Blue wire (occupancy) of the primary power pack. Never connect the Red (+24VDC) wires of two different
    power packs together.
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Occupancy Sensor
Power Pack

Cat. 
OSP20

OSP20-RD0 (with HVAC relay)
Load Ra

20A, 2400W @ 120V, 60Hz – Incandescent
20A, 2400VA @ 120V, 60Hz – Fluorescent
20A, 5540VA @ 277V, 60Hz – Fluorescent

1 HP @ 120VAC – Motor Load
2 HP @ 240V, 60Hz – Motor Load
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Universal Power Supply
DESCRIPTION 
The Universal Power Supply provides power to multiple 
devices and accommodates North American and International 
voltages. This unit features six 12 VDC outputs and two NEMA 
AC voltage outputs.
SPECIFICATIONS 
Input AC Voltage Rating:  100-240 VAC
Internal AC Fuse:  Input current, 2 Amps (AC/DC  
 power supply)
Input Current Rating:  15 Amps, max (AC/DC power  
 supply and 2 NEMA connectors)
DC Power Output:  40 Watts, (3.3 Amps), max
Source Frequency:  47-63 Hz
AC Output:  UL/CSA 15 Amp @ 125 VAC
DC Outputs:  6 Outputs at 12 VDC ± 1%;  
 Max current = 3.3 Amps
LED:  One green LED; indicates DC  
 Power is available
Figure 1:
A. Screws (4) E. Romex
B. Cable Clamp F.  Wiring Access Plate
C. Cable Knockout G. Opening in base of Structured 
D. Housing  MediaTM Enclosure for Power  
  Module

INSTALLATION
IMPORTANT SAFETY INSTRUCTIONS––READ BEFORE 
INSTALLING
Carefully read all installation instructions before beginning 
your intended installation. If you do not understand any part of 
them, consult a qualified electrician. This unit must be installed 
and/or used in accordance with appropriate electrical codes 
and regulations.
WARNING:   TO AVOID FIRE, SHOCK, OR DEATH: TURN 

OFF POWER AT CIRCUIT BREAKER OR 
FUSE AND TEST THAT THE POWER IS OFF 
BEFORE WIRING!

WARNING:   THIS DEVICE IS INTENDED FOR SINGLE 
BRANCH CIRCUIT INSTALLATIONS ONLY.

WARNING:  USE THIS DEVICE ONLY WITH COPPER OR 
COPPER-CLAD WIRE!

1.  When positioning the enclosure on the wall, ensure that 
adequate space is provided for the Universal Power Supply 
and any associated wiring.

2.  Remove the large rectangular knockout in the bottom of the 
enclosure.

3.  Remove the wiring access plate. A user-supplied conduit 
fitting or cable clamp is recommended to ready the cable 
entry hole for electrical wiring (Figure 1).

4.  Verify the power is off and feed electrical wire through 
the hole in the bottom panel of the Power Supply. An 
independent 15 amp circuit should be used to provide 
power to the enclosure’s Universal Power Supply.

Universal Power Supply

Bloc d’alimentation universel

Fuente de Alimentación 
Universal

Fuente de Alimentación Universal
DESCRIPCIÓN
El bloque de alimentación Universal provee energía a 
productos múltiples y acomoda voltajes de Norte América e 
Internacionales. Esta unidad tiene 6 salidas 12VCD y dos 
salidas de voltaje NEMA CA.
ESPECIFICACIONES
Entrada de Voltaje Vca: 100-240 Vca
Fusible CA Interno:   Corriente de entrada, 2A (Fuente de 

alimentación CA/CC)
Corriente de Entrada:   15 Amp. Máx., (suministra corriente 

CA/CD y dos conectores NEMA)
Potencia de Salida CC:  40 Vatios, (3,3A), máximo
Frecuencia de Fuente:  47/63 Hz
Salida Vca:  UL/CSA 15 A en 125 Vca
Salidas CC:   6 Salidas a 12Vcc ± 1%; Corriente 

máxima: 3,3A
Corriente Máxima:  3,3A (Total)
Luz Indicadora (LED):   1 luz verde LED; indica 

disponibilidad de Vcc
Ilustración 1:
A. Tornillos (4 unidades) E. Romex
B. Abrazadera de Cables F.  Placa para Acceso de
C. Tapas Removibles de Cables Cables
D. Caja G.  Apertura en la base de 

la Caja del Structured 
Media para el Módulo de 
Alimentación

INSTALACIÓN
INSTRUCCIONES IMPORTANTES PARA SU SEGURIDAD 
– LEALAS ANTES DE COMENZAR LA INSTALACION
Lea todas las instrucciones de instalación detalladamente 
antes de comenzar la instalación. Si no comprende partes de 
esta, consulte a un electricista. Esta unidad debe ser instalada 
respetando las normas y códigos eléctricos locales.
ADVERTENCIA:  PARA EVITAR FUEGO, DESCARGA 

ELECTRICA, O MUERTE, INTERRUMPA 
EL PASO DE ENERGIA MEDIANTE EL 
INTERRUPTOR DE CIRCUITO O FUSIBLE. 
¡ASEGURESE QUE EL CIRCUITO NO 
ESTE ENERGIZADO ANTES DE INICIAR 
LA INSTALACION!

ADVERTENCIA:  ESTE ARTEFACTO ESTA DISEÑADO 
PARA INSTALAR SOLO EN CIRCUITOS 
INDEPENDIENTES.

ADVERTENCIA:  ¡CON ESTE ARTEFACTO UTILICE SOLO 
CABLES DE COBRE O CON GANCHOS 
DE COBRE!

1.  Cuando apoya la caja sobre la pared, asegúrese que 
posee suficiente espacio para la Fuente de Alimentación 
Universal y sus cable.

2.  Retire la tapa grande rectangular removible en la base de 
la caja.

3.  Retire la placa de acceso de cable. Se recomienda el 
uso de un accesorio o gancho de cable para preparar el 
agujero de la entrada de cables (Ilustración 1).

4.  Verifique que la energía eléctrica está apagada y coloque 
el cable a través del agujero en la parte inferior del panel 
de la Fuente de Alimentación. Un circuito independiente de 
15A debe ser utilizado para alimentar a la caja de la Fuente 
de Alimentación Universal.

Bloc d’alimentation universel
DESCRIPTION
Ce bloc universel peut alimenter plusieurs dispositifs 
suivant diverses normes de courant tant nord-américaines 
qu’internationales. Il présente six sorties de 12 V c.c. et deux 
connecteurs NEMA c.a.
FICHE TECHNIQUE
Tension d’entrée en courant alternatif : de 100 à 240 V c.a.
Fusible c.a. interne :   courant d’entrée de 2 A (alimentation 

c.a./c.c.)
Courant d’entrée nominal :   15 A max. (bloc c.a./c.c. et deux 

connecteurs NEMA)
Puissance de sortie en courant continu :  40 W (3,3 A), max.
Fréquence d’entrée :  de 47 à 63 Hz
Sortie en courant alternatif :  hom. UL/CSA : 15 A à 125 V c.a.
Sorties en courant continu :   6 sorties à 12 V c.c. ± 1 %; 

courant max. de 3,3 A
Témoin :   un témoin vert indiquant la présence de courant 

continu

Figure 1 :
A. Vis (4) E. Câble romex
B. Collier de serrage F.  Plaque d’accès au câblage
C. Débouchure de câble G. Ouverture au bas du CMS
D. Boîtier (logement) pour le module  
 d’alimentation
INSTALLATION
IMPORTANTES CONSIGNES DE SÉCURITÉ – À LIRE 
AVANT DE COMMENCER
On doit lire attentivement ces directives dans leur ensemble 
avant de procéder; à défaut de bien les comprendre, en tout 
ou en partie, on doit faire appel à un électricien qualifié. Ce 
dispositif doit être installé ou utilisé conformément aux codes 
de l’électricité en vigueur.
AVERTISSEMENT :  POUR ÉVITER LES 

RISQUES D’INCENDIE, DE 
CHOC ÉLECTRIQUE OU 
D'ÉLECTROCUTION, COUPER LE 
COURANT AU FUSIBLE OU AU 
DISJONCTEUR ET S’ASSURER 
QUE LE CIRCUIT SOIT BIEN 
COUPÉ AVANT DE PROCÉDER À 
L’INSTALLATION!

AVERTISSEMENT :  CE DISPOSITIF EST EXCLUSIVEMENT 
CONÇU POUR LES INSTALLATIONS À 
UNE SEULE DÉRIVATION.

AVERTISSEMENT :  N’UTILISER CE DISPOSITIF QU’AVEC 
DU FIL DE CUIVRE OU PLAQUÉ 
CUIVRE!

1.  Lorsqu’on place le logement (CMS) contre un mur, on doit 
prévoir suffisamment d’espace pour le bloc d’alimentation 
et son câblage.

2.  Retirer la grande débouchure rectangulaire au bas du 
logement.

3.  Retirer la plaque d’accès au câblage. On recommande de 
se servir d’un raccord de conduit ou d’un collier de câble 
(non compris) pour protéger le câblage électrique entrant 
(Figure 1).

DI-080-47605-20A-X2

47605-PSC

Installation Instructions Instrucciones de InstalaciónDirectives d'installation
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INSTRUCTION SHEETS
Additional Templates
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Instruction Sheet ChecklistInstruction Sheet Checklist

Things to address when beginning new or modifying existing artwork:

Folder:

• Part No. (valid, present)

• Cat. No. (valid, present)

• Art Request No. (pack track info)

• Plant No. (valid, present)

• Approval Names (valid, present)

• Folder Contents (Packaging Request Form, ECO's, instructions, mark-ups, notes to PDP art)

Instruction Sheet Peer Review:

� Format of document (old/new)

� Logos (latest updated version)

� Part No. (valid, placement as it pertains to fold scheme)

� Warnings and Cautions (specifically updated standard statements)

� Wiring (# AWG, strip gage lengths, line art diagram formats)

� Warranty (latest updated, length in years, latest updated Mexican)

� Technical Information (website address, telephone number)

� Fold Scheme (current format w/spec box, die lines w/dimensions)

� Update IS PK Cross Ref List
(add new row if necessary, update rev level, confirm corresponding Cat Nos)
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Fold Scheme SpecsFold Scheme Specs

How to determine fold scheme of instruction sheets:

1. Verify pack mode by checking BOM or sample.

2. Verify size of pack mode.

3. Use already existing fold scheme or create one that will fold down and fit into packaging easily ensuring 
that the instruction sheet part number is visible upon final fold.

4. Fold scheme will be the last page of the instruction sheet/manual and is not to be printed.
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Private Label

You must follow any Private label requirements. All specs and templates can be found on the Server
afp://w2lnpkg1. See Packaging Service Graphics, “Customer Pkg Spec” Folder.
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Promotion Displays 12
SPECS:
• All displays must have a comp created to ensure accuracy. Artist must make a final comp before 

release no matter how minor a change there was to the artwork. No exceptions. 
Vendor comps are NOT an acceptable form of comp.

• Photo of comp is required to send to the plant.

• Die lines must be received by manufacturing vendor.

• Assembly instructions for the Manufacturing Plant and Customer are required.
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Proofreader Marks 13

Espresso Graphics HANDBOOK.v1©2004 Deborah Roberti     espresso@sonic.net    espressographics.com 7

MARK IN
CORRECTION TEXT MARK MARGIN

MARK IN
CORRECTION TEXT MARK MARGIN

PROOFREADER’S MARKS
Desktop Publishing
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Translations 14
The following are the procedures for translations:

1. All English must have final approval before translations are incorporated in most cases.

2. Translations must be made from the PDP official translators. Spanish is provided by Iris Canepa and 
the French from Marie-Andrée Mongeau of OPUS; email at marie.opus@videotron.ca (514-630-8889). 

3. Follow PDP artwork approval procedure (See page 60). Please copy Catherine Therrien on all emails 
concerning French approvals. Her approval is required. 

4. Any requested changes by persons other then our official translators, must be reviewed and approved by the 
translators. If a change is rejected, a reply to the requestors email should be made explaining as to why 

it was rejected.

5. If many mark ups or changes are made to a document, i.e. engineering changes or marketing changes, 
it will require another round of approval.
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15Bill of Materials
Manufacturing Engineering log in.

PACKAGING DATA
3-return
24-return

I-for 2nd pg
(item description)

Print-view keypad
(PA1)

RATINGS/COO
3-return
22-return
F- forward for lines 7.8.9.

STRUCTURED?
3-return
16-return

(item has no-where 
used=not structured)

PACK TO....
26-return (drawings)
16-return (art req.)

art req. #_______

x-rec
x-comp

sent to_______

u (at bottom)

return (3-times)

MATERIAL TYPE
3-return 
14

PL 90 LAs
7-return
10-(Tab down 3 times.)
Crtn lab fmt fld. 
ENTER 999

u-enter 
(record modified)

check
3-return
22

CARTON DESCRIP.
7-return
18

CHECK PAK-TRAK
26-return
20
DEPT. CODE

CHECK UL LIST
3-return
12

PRODUCT MGR.
3-return
42

DRAWING FILE
26-return
10
PART #
(D) for Display

Ref PK WERE USED
3-return
28-return

To find what items 
use ref. PK.

EXTENDED DESCRIPT.
3-return 
14

WHSE INVENTORY
2-return
1-return

PK MASTER LIST
3-return 
5-return
Used to locate PK #’s 
used.

MULTISOURCE INQUIRY
2-return 
1-return (ent. item)
N-return

COLOR ABBREV.
16-return 
2-return (ent. 0325)
Enter D, #1 to display


